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Die Software »IP-Console Client«
Die Software IP-Console Client stellt Ihnen innerhalb des IP-Netzwerks einen virtuel-
len Arbeitsplatz zur Verfügung. An diesem virtuellen Arbeitsplatz können Sie das 
Matrixsystem bedienen und konfigurieren.

Die Software wird in separaten Varianten für folgende Betriebssysteme angeboten:

 Windows
 GNU/Linux

Systemvoraussetzungen
Die Installation und der Betrieb der Software IP-Console Client stellt die unten aufge-
listeten Voraussetzungen an den Computer, auf welchem die Software installiert 
und betrieben wird.

Windows-Variante

 ungefähr 20 MB freier Festplattenspeicher
 Windows XP, 2003, Vista oder 7
 getestete Windows-Version:
 Microsoft Windows 7

GNU/Linux-Variante

 ungefähr 20 MB freier Festplattenspeicher
 getestete GNU/Linux-Distributionen
 GNU/Linux Ubuntu 12.10
 GNU/Linux Ubuntu 13.04

HINWEIS: In diesem Handbuch wird exemplarisch die Bedienung der Windows-
Variante der Software beschrieben.

Die Varianten unterscheiden sich ausschließlich in der optischen Gestaltung.
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Installation
Die Software wird in separaten Varianten für die Betriebssysteme Windows und 
GNU/Linux angeboten.

Installieren Sie die gewünschte Variante nach den Anweisungen der folgenden 
Abschnitte.

Windows-Variante

So installieren Sie die Software unter einem unterstützten Windows-Betriebssystem:

1. Legen Sie die Installations-CD in Ihr CD-Laufwerk ein.

2. Öffnen Sie das Verzeichnis \IPClient\Deutsch\Windows mit dem Windows Explorer.

3. Führen Sie die Datei Setup.exe durch einen Doppelklick aus.

4. Lesen Sie die Hinweise des Setup-Assistenten und klicken Sie auf Weiter.

5. Lesen Sie die Lizenzbestimmungen und bestätigen Sie diese durch Aktivieren 
der Option Ich stimme zu.

6. Klicken Sie auf Weiter.

7. Geben Sie den gewünschten Zielordner auf einem lokalen Laufwerk an.

8. Wählen Sie, ob die Installation für den aktuellen Benutzer oder für alle Benutzer des 
Computers erfolgen soll.

9. Bestätigen Sie Ihre Eingaben durch Klick auf Weiter.

10.Starten Sie den Installationsvorgang durch Klick auf Weiter.

11.Nach Beendigung des Installationsvorgangs klicken Sie auf Schließen.

GNU/Linux-Variante

So installieren Sie die Software unter einer unterstützten GNU/Linux- 
Distribution:

1. Legen Sie die Installations-CD in Ihr CD-Laufwerk ein.

2. Öffnen Sie das Verzeichnis \IPClient\Deutsch\Linux der CD.

3. Führen Sie den Befehl su -c ip-client-2.4.000-00634.run aus.

4. Geben Sie auf Aufforderung das Root-Passwort ein.

HINWEIS: Wird die Lizenzvereinbarung abgelehnt, ist das Fortsetzen der 
Installation nicht möglich!

TIPP: Klicken Sie auf Durchsuchen um die Baumstruktur der Laufwerke des 
Computers zu betrachten. Das Erstellen und Auswählen des Zielverzeichnisses 
ist so komfortabel möglich.
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Erste Schritte
Die grundlegende Bedienung der Software IP-Console Client lernen Sie in diesem 
Kapitel kennen.

Start der Software
Zum Start der Software IP-Console Client stehen Ihnen folgende Möglichkeiten zur 
Verfügung:

Windows

So starten Sie die Software unter einem unterstützten Windows-Betriebssystem:

 Klicken Sie im Windows-Startmenü auf die folgenden Einträge:
Start > Programme > Guntermann & Drunck GmbH > IP-Console > IP-Console Client

 Doppelklicken Sie die Desktop-Verknüpfung der Software IP-Console Client

GNU/Linux

So starten Sie die Software unter einer unterstützten GNU/Linux-Distribution:

1. Geben Sie in der Kommandozeile den Befehl ip-client ein.

2. Betätigen Sie die Eingabetaste.

HINWEIS: Detaillierte Erläuterungen der Funktionen und Einstellungen erfolgen 
in den folgenden Kapiteln dieses Handbuchs.

HINWEIS: Beim ersten Start der Software, werden Sie zur Auswahl der gewünsch-
ten Sprache aufgefordert.

HINWEIS: Beim ersten Start der Software, werden Sie zur Auswahl der gewünsch-
ten Sprache aufgefordert.
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Eine Verbindung zum KVM-Matrixsystem herstellen
Nach dem Start der Software können Sie eine Sitzung mit dem KVM-Matrixsystem 
starten. Hiernach wird innerhalb der Software IP-Console Client der virtuelle Arbeits-
platz dargestellt.

Eine Sitzung mit dem KVM-Matrixsystem starten

So starten Sie einen Sitzung mit dem KVM-Matrixsystem:

1. Wählen Sie im Pull-Down-Menü Sitzung eine bereits erstellte Sitzung aus.

2. Geben Sie im Abschnitt Authentifizierung den Benutzernamen und das Kennwort Ihres 
Benutzerkontos ein.

3. Wählen Sie im Abschnitt Sprachwahl die von Ihnen gewünschte Sprache (Deutsch 
oder Englisch).

4. Optional: Klicken Sie auf Erweitert, falls Sie die (s. nächster Abschnitt) erweiterten 
Sitzungseinstellungen konfigurieren möchten.

5. Starten Sie den Verbindungsaufbau (s. Seite 18) durch Klick auf Verbinden.

Erweiterte Sitzungseinstellungen

Klicken Sie im Anmeldung-Fenster links unten auf Erweitert um die erweiterten Sit-
zungseinstellungen einzusehen und ggf. zu ändern:

HINWEIS: Die Erstellung eines Sitzungsprofiles wird auf Seite 12 erläutert.

WICHTIG: Falls Ihnen die Zugangsdaten nicht vorliegen, erfragen Sie diese beim 
Administrator des Matrixsystems.

HINWEIS: Beim ersten Start der Software IP-Console Client wird der Erstinbetrieb-
nahmemodus (s. Seite 17) gestartet.

Mausbremse global 
aktiviert:

Wenn sowohl auf Ihrem lokalen Computer als auch auf 
dem Zielrechner eine Mausbeschleunigung durch-
geführt wird, hat dies zur Folge, dass sich der Mauszei-
ger auf dem Zielrechner sehr schnell bewegt und 
hierdurch die Bedienung erschwert.

Aktivieren Sie diese Option (s. Seite 43) um die Zeiger-
geschwindigkeit zu „bremsen“.

Mausgesten aktiviert: Mausgesten ermöglichen Ihnen das Auslösen der Maus 
aus dem Client-Fenster und das Öffnen des Steuerboards
durch die Ausführung von vorkonfigurierten Mausbe-
wegungen (s. Seite 41).
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Das Client-Fenster
Nachdem die Software IP-Console Client eine Verbindung zum KVM-Matrixsystem 
aufgebaut hat, erscheint auf Ihrem Bildschirm das Client-Fenster:

Autofit deaktiviert: Die automatische Größenanpassung passt bei jedem 
Aufschaltvorgang die Größe des Client-Fensters an die 
aktuelle Auflösung des Zielrechners an.

Deaktivieren Sie die Funktion wenn Sie eine feste 
Breite und Höhe des Client-Fensters (s. Seite 38) vor-
geben möchten.

NumLock-Nachführung 
aktivieren:

Diese Funktion gleicht den Schaltzustand (an/aus) der 
Taste »Num  Lock« zwischen dem lokalen Computer 
und dem Zielrechner ab.

CapsLock-Nachführung 
aktivieren:

Diese Funktion gleicht den Schaltzustand (an/aus) der 
Taste »Caps Lock« zwischen dem lokalen Computer und 
dem Zielrechner ab.

ScrollLock-Nachführung 
aktivieren:

Diese Funktion gleicht den Schaltzustand (an/aus) der 
Taste »Scroll Lock« zwischen dem lokalen Computer 
und dem Zielrechner ab.

Statuszeile: Wählen Sie, an welcher Stelle des Client-Fensters die 
Statuszeile (s. Seite 26) angezeigt wird:

 Oberer Fensterrand
 Unterer Fensterrand



Erste Schritte
G&D IP-Console Client · 6

In diesem Fenster wird das On-Screen-Display des Matrixsystems bzw. die Bild-
schirmausgabe des aufgeschalteten Zielrechners dargestellt.

Informationen der Titelzeile

In der Titelzeile des Client-Fenster werden neben dem Namen der Software fol-
gende Informationen angezeigt:

HINWEIS: Da die Darstellung des On-Screen-Displays nicht vom KVM-Matrixsy-
stem, sondern von der Software IP-Console Client erstellt wird, ist die Änderung der 
Positionierung und die Synchronisationseinstellung nicht möglich!

Bedienungsstatus: Ist die Bedienung des Zielrechners innerhalb des Client-Fen-
sters aktiv, wird in der eckigen Klammer Bedienung aktiv ange-
zeigt.

Andernfalls wird in der eckigen Klammer Bedienung inaktiv
angezeigt.

Name der 
Sitzung:

Im Abschnitt Sitzung wird der Name der für den Verbindungs-
aufbau erforderlichen Verbindungseinstellungen angezeigt.

Name des 
Zielrechners:

Im Abschnitt Zielrechner wird der Name des aufgeschalteten 
Zielrechners angezeigt.
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Informationen der Statuszeile

In der Statuszeile werden folgende Informationen (von links nach rechts) angezeigt:

Belegungssymbol: Das Symbol zeigt an, ob ein oder mehrere Benutzer auf den 
Zielrechner zugreifen.

Name des 
Zielrechners:

Name des aufgeschalteten Zielrechners des KVM-Matrix-
systems

Bezeichnung des 
Videoprofils:

Bezeichnung des Videoprofils, welches dem aufgeschalteten 
Zielrechner zugeordnet wurde

Bildfrequenz: Anzahl der Bildaktualisierungen pro Sekunde die im Client-
Fenster dargestellt werden

Datentransferrate: Datentransferrate (in Kilobyte pro Sekunde) zwischen dem 
KVM-Matrixsystem und der Software IP-Console Client.

»Num Lock«-LED Die LED wird hellgrün dargestellt, wenn die Num-Lock-
Funktion auf dem Zielrechner aktiv ist.

Ist die Funktion nicht aktiv, wird die LED dunkelgrün dar-
gestellt.

»Caps Lock«-LED Die LED wird hellgrün dargestellt, wenn die Feststelltaste auf 
dem Zielrechner betätigt wurde.

Ist die Feststelltaste nicht aktiv, wird die LED dunkelgrün 
dargestellt.

»Scroll Lock«-LED Die LED wird hellgrün dargestellt, wenn die Scroll-Lock-
Funktion auf dem Zielrechner aktiv ist.

Ist die Funktion nicht aktiv, wird die LED dunkelgrün dar-
gestellt.

HINWEIS: Die Statuszeile kann wahlweise oben oder unten innerhalb des Client-
Fensters angezeigt werden (s. Seite 26).



Erste Schritte
G&D IP-Console Client · 8

Auslösen der Maus aus dem Client-Fenster

Ist die Bedienung des On-Screen-Displays des KVM-Matrixsystems bzw. des Ziel-
rechners innerhalb des Client-Fensters aktiv, wird in der eckigen Klammer Bedienung 
aktiv angezeigt.

Die Bedienung des lokalen Computers mit den Eingabegeräten ist erst nach Auslö-
sen der Maus aus dem Client-Fenster möglich.

So lösen Sie die Maus aus dem Client-Fenster aus:

 Drücken und halten Sie die Tasten Strg+Shift während Sie zusätzlich die 
linke Maustaste betätigen.

Verschieben des Fensterausschnittes (Scrollen)

Ist die Bildschirmauflösung des Zielrechners größer als jene Ihres Computers, so 
kann nur ein Ausschnitt des Bildschirminhaltes des Zielrechners auf Ihrem Monitor 
angezeigt werden.

Über die Bildlaufleisten des Client-Fensters oder mit den Schaltflächen im Scrollen-
Bereich des Steuerboards können Sie den darzustellenden Ausschnitt auswählen.

So wählen Sie den darzustellenden Ausschnitt mit der Maus:

 Klicken Sie auf die Bildlaufleisten des Client-Fensters zur Auswahl des darzustel-
lenden Ausschnitts.

 Klicken Sie auf die Schaltflächen (s. u.) im Scrollen-Bereich des Steuerboards.

So wählen Sie den darzustellenden Ausschnitt mit der Tastatur:

1. Stellen Sie sicher, dass das Client-Fenster aktiv und die »Num  Lock«-Funktion 
ausgeschaltet ist.

2. Halten Sie Strg+Shift gedrückt, während Sie eine der 
rechts abgebildeten Navigationstasten (Num-Taste) des 
numerischen Tastenblocks betätigen:

 Die Tasten 8 (hoch), 6 (rechts), 2 (runter) und 4 (links) 
bewegen den Bildausschnit in kleinen Schritten.

 Die Tasten 9 (rechts oben), 3 (rechts unten), 1 (links 
unten) und 7 (links oben) positionieren den Bildaus-
schnitt an die entsprechenden Positionen.

 Die Tasten 5 zentriert den Bildausschnitt in der Mitte.

HINWEIS: In diesem Status werden die Tastatureingaben und Mausaktionen am 
lokalen Computer direkt an den Zielrechner weitergeleitet.

TIPP: Alternativ kann das Auslösen der Maus mit einer Mausgeste (s. Seite 41) 
erreicht werden.
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Umschalten zwischen den Zielrechnern
Zwischen den am KVM-Matrixsystem angeschlossenen Zielrechnern können Sie 
wahlweise über das On-Screen-Display oder über das Steuerboard umschalten.

Nähere Erläuterungen zu den jeweiligen Verfahren erhalten Sie in den folgenden 
Abschnitten.

Umschaltung über das Steuerboard

So schalten Sie einen Zielrechner über das Steuerboard auf:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Zielrechner.

3. Verwenden Sie ggf. die Filterfunktion (s. Seite 21), um die Auflistung der Ziel-
rechner einzugrenzen.

4. Wählen Sie mit der Maus oder der Tastatur (Pfeiltasten, Pos 1 oder Ende) einen  
Zielrechner aus.

5. Führen Sie einen Doppelklick aus oder betätigen Sie die Eingabetaste.

Umschaltung über das On-Screen-Display (OSD)

So schalten Sie einen Zielrechner über das On-Screen-Display auf:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie auf die Schaltfläche AdonIS.

3. Wählen Sie den aufzuschaltenden Zielrechner mit den Pfeiltasten aus.

4. Betätigen Sie die Eingabetaste.

Wechsel zwischen Zielrechner und lokalem 
Computer
Möchten Sie während einer Sitzung auf einem Zielrechner, Tastatur und/oder 
Mausaktionen auf Ihrem lokalen Computer durchführen, ist dies ohne Beendigung 
der Sitzung oder Aufruf des Steuerboards möglich.

Detaillierte Informationen zu diesem Thema finden Sie im Abschnitt Auslösen der 
Maus aus dem Client-Fenster auf Seite 8.

TIPP: Klicken Sie im Steuerboard auf die Schaltfläche Last Target (s. Seite 22), um 
sich auf den zuletzt aktiven Zielrechner aufzuschalten.
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Grunddaten und Kommentar einsehen bzw. editieren
Die Grunddaten eines Zielrechners werden bei Anwendung der Ansichtoption 
Detail in der Auflistung der Zielrechner angezeigt.

Alternativ können die Grunddaten sowie der Kommentar eines Zielrechners im 
Eigenschaften-Fenster betrachtet werden.

So rufen Sie die Grunddaten und den Kommentar eines Zielrechners auf:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Zielrechner.

3. Verwenden Sie ggf. die Filterfunktion (s. Seite 21), um die Auflistung der Ziel-
rechner einzugrenzen.

4. Klicken Sie mit der rechten Maustaste auf den gewünschten Zielrechner und 
anschließend auf Eigenschaften im Kontextmenü.

Der Name, die physikalische Adresse und der Kommentare des Zielrechners werden 
Ihnen angezeigt.

5. Optional: Geben Sie den gewünschten Kommentar im Feld Kommentar ein.

6. Klicken Sie auf OK, um die Änderungen zu speichern oder verwerfen Sie die 
Änderungen durch Klick auf Abbrechen.

Timeout bei Inaktivität
Haben Sie während einer aktiven Sitzung innerhalb von 10 Minuten (Standardein-
stellung) keine Tastatur- bzw. Mausaktion durchgeführt, wird die Beendigung der 
aktiven Sitzung eingeleitet.

Ein Informationsfenster informiert Sie nach Ablauf des Timeouts über die bevorste-
hende Beendigung der Sitzung und bietet Ihnen folgende Wahlmöglichkeiten:

 Sitzung beenden: Klicken Sie auf diese Schaltfläche, um die aktive Sitzung sofort zu 
beenden.

 Fortsetzen: Klicken Sie auf diese Schaltfläche, um die aktuelle Sitzung fortzusetzen.

HINWEIS: Den Kommentar des Zielrechners können Sie beliebig editieren.

TIPP: Über die Webapplikation Config Panel können Sie die Einstellung des Timeouts 
ändern. Die entsprechende Einstellung finden Sie auf dem Reiter KVM-Server der 
Konfigurationseinstellungen des Matrixswitches.
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Einsatz von Hotkeys während einer Sitzung
Innerhalb eines aktivierten Client-Fensters stehen Ihnen die folgenden Hotkeys 
während einer Sitzung zur Verfügung.

Beenden der aktiven Sitzung
Zum Beenden der aktiven Sitzung haben Sie zwei Möglichkeiten: Sie können die 
Sitzung über das Menü des Steuerboards oder durch das Schließen des Client-Fen-
sters beenden

So beenden Sie die aktive Sitzung:

 Ist das Steuerboard geöffnet, klicken Sie in diesem auf das Menü Aktion > Sitzung 
schließen.

 Andernfalls schließen Sie das Client-Fenster durch einen Klick auf das Schließen-
Symbol des Fensters.

Beenden der Software

So beenden Sie die Ausführung der Software auf Ihrem Computer:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Aktion > Beenden.

Strg+Shift+Maustaste Auslösen der Maus aus dem aktiven Client-Fenster

Strg+Shift+Num-Taste In Kombination mit dem Ziffernblock der Tastatur, 
können Sie innerhalb des Client-Fensters navigieren.
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Sitzungsprofile verwalten
Für jedes G&D-Gerät innerhalb des IP-Netzwerkes, das einen IP-Arbeitsplatz zur 
Verfügung stellt, können Sie ein separates Sitzungsprofil erstellen.

Erstellen eines neuen Sitzungsprofils

So erstellen Sie ein neues Sitzungsprofil:

1. Klicken Sie auf Neu im Abschnitt Sitzung des Anmeldung-Dialogs.

2. Erfassen Sie die Grunddaten des Sitzungsprofils:

3. Optional: Klicken Sie auf Erweitert, falls Sie Angaben zum Eingabemodus, zur  Bedie-
nung, zur Verschlüsselung und/oder Bandbreite (s. Seite 14) tätigen möchten.

4. Klicken Sie auf OK, um das neue Sitzungsprofil zu speichern oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.

Sitzungsname: Name des Sitzungsprofils

IP-Adresse/Name: IP-Adresse des G&D-Gerätes

Bei Namensauflösung über einen DNS-Server geben Sie alternativ den 
Namen ein.

Port: Port-Nummer (Standard: 27998), über welchen die Kommuni-
kation mit dem G&D-Gerät aufgebaut wird

Hotkey-Auswahl: Tastenkombination zum Aufruf des Steuerboards (s. Seite 20) 
während einer Sitzung:

 Ctrl+Shift: Tastenkombination Strg + Shift
 Alt+Shift: Tastenkombination Alt + Shift
 Ctrl+Alt: Tastenkombination Strg + Alt

Open Access- 
Konsole:

Aktivieren Sie diese Option, falls der virtuelle Arbeitsplatz 
in der Betriebsart Open Access betrieben wird.

In diesem Fall ist die Eingabe von Benutzername und Kennwort zum 
Verbindungsaufbau nicht erforderlich.
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Bearbeiten eines Sitzungsprofils

So ändern Sie die Einstellungen ein Sitzungsprofils:

1. Wählen Sie im Abschnitt Sitzung des Anmeldung-Dialogs das zu editierende Pro-
fil aus und klicken Sie auf Bearbeiten.

2. Prüfen und ändern Sie die bereits erfassten Daten des Sitzungsprofils:

3. Optional: Klicken Sie auf Erweitert, falls Sie Angaben zum Eingabemodus, zur  Bedie-
nung, zur Verschlüsselung und/oder Bandbreite (s. Seite 14) tätigen möchten.

4. Klicken Sie auf OK, um das neue Sitzungsprofil zu speichern oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.

Löschen eines Sitzungsprofils
1. Wählen Sie im Abschnitt Sitzung des Anmeldung-Dialogs das zu löschende Profil 

aus und klicken Sie auf Löschen.

2. Prüfen Sie die Angaben der Sicherheitsabfrage und klicken Sie anschließend auf 
Ja, um das Sitzungsprofil zu löschen oder auf Abbrechen, um den Vorgang abzu-
brechen.

Sitzungsname: Name des Sitzungsprofils

IP-Adresse/Name: IP-Adresse des G&D-Gerätes

Bei Namensauflösung über einen DNS-Server geben Sie 
alternativ den Namen ein.

Port: Port-Nummer (Standard: 27998), über welchen die Kom-
munikation mit dem G&D-Gerät aufgebaut wird

Hotkey-Auswahl: Tastenkombination zum Aufruf des Steuerboards (s. Seite 20) 
während einer Sitzung:

 Ctrl+Shift: Tastenkombination Strg + Shift
 Alt+Shift: Tastenkombination Alt + Shift
 Ctrl+Alt: Tastenkombination Strg + Alt

Open Access- 
Konsole:

Aktivieren Sie diese Option, falls der virtuelle Arbeits-
platz in der Betriebsart Open Access betrieben wird.

In diesem Fall ist die Eingabe von Benutzername und Kennwort 
zum Verbindungsaufbau nicht erforderlich.
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Erweiterte Einstellungen des Sitzungsprofils
Klicken Sie in den Einstellungen eines Sitzungsprofils (s. Seite 13) auf Erweitert, wer-
den zusätzliche Eingabe- und Auswahlfenster eingeblendet.

In diesen können Sie Angaben zum Eingabemodus, zur Bedienung, zur Verschlüs-
selung und/oder Bandbreite tätigen.

Eingabemodus

Wird ein neues Profil erstellt, wird die Funktion Direct Keyboard Input automatisch 
aktiviert.

Dies hat zur Folge, dass die Tastatureingaben am lokalen Computer auch bei inakti-
vem Client-Fenster (s. Seite 6) an den Zielrechner weitergeleitet werden.

Bedienung

Bei IP-basierten KVM-Produkten werden die analogen Tastatur-, Video- und Maus-
Signale digitalisiert und anschließend über das IP-Netzwerk übertragen.

Abhängig von der Auflösung und Farbtiefe des Videosignals vom Zielrechner kann 
die zur Verfügung stehende Bandbreite durch ein höheres Datenaufkommen stark 
beansprucht werden.

Um diesen Effekt zu mindern, können Sie im Bereich Bedienung einstellen, wie die 
zur Verfügung stehende Bandbreite bevorzugt verwendet werden soll.

Drei Einstellmöglichkeiten stehen Ihnen zur Verfügung:

HINWEIS: Voraussetzung zur Weiterleitung der Tastatureingaben an den Zielrech-
ner ist, dass das Client-Fenster den Fokus besitzt.

HINWEIS: Bei Einsatz einer GNU/Linux-Distribution ist zunächst das Steuerboard 
zu schließen, bevor bei inaktiven Client-Fenster Eingaben möglich sind.

HINWEIS: Dies kann zu Performanceeinbußen bei schmalbandigen Verbindungen 
führen. Eine mögliche Auswirkung ist beispielsweise, dass für das Maus-Signal nur 
noch minimale Bandbreite zur Verfügung steht und eine flüssige Bedienung der 
Maus somit erschwert wird.

anzeigen und 
bedienen:

Der Bildschirmaufbau und der Mauszeiger werden gleichrangig 
behandelt.

Diese Einstellung wird bei Einsatz einer LAN-Verbindung empfohlen 
(Standardeinstellung).

anzeigen: Der Bildschirmaufbau wird bevorzugt behandelt.

Diese Einstellung wird empfohlen, wenn bei einer schmalbandigen Verbin-
dung die Aufgabe hauptsächlich im „Beobachten“ besteht.
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Verschlüsselung

Die Datenübertraugung zwischen dem Matrixsystem und der Software kann durch 
den Einsatz von Verschlüsselungsoptionen gesichert werden.

Während die Übertragung der Authentifizierungsdaten immer gesichert ist, können 
Sie die Daten der Tastatur-/Maus-Aktionen und des übertragenen Videosignals 
optional verschlüsseln.

Folgende Verschlüsselungsoptionen stehen zur Verfügung:

bedienen: Der Mauszeiger wird bevorzugt behandelt.

Diese Einstellung wird empfohlen, wenn bei einer schmalbandigen Verbin-
dung die Aufgabe hauptsächlich in der Administration und Konfiguration 
der Zielrechner besteht und ein schneller Bildschirmaufbau von nachrangi-
ger Bedeutung ist.

WICHTIG: Werden sensible Daten auf dem Zielrechner angezeigt und editiert, ist 
die Aktivierung der Verschlüsselung des Input- und des Video-Kanals bei Daten-
übertragung über das Internet empfehlenswert.

Wird der Datenverkehr über eine gesicherte VPN-Verbindung geleitet, ist die Ver-
schlüsselung üblicherweise nicht erforderlich.

HINWEIS: Bedenken Sie, dass jede zusätzliche Verschlüsselung Zeit erfordert und 
somit die Performance beeinflusst.

CTRL-Kanal: Über diesen Kanal wird der Datenaustausch im Rahmen des 
Anmeldevorgangs an das KVM-Matrixsystem übertragen.

Die Datenübertragung dieses Kanals wird immer verschlüsselt.

Input-Kanal: Über diesen Kanal werden die Tastatur-/Maus-Signale zum 
KVM-Matrixsystem übertragen.

Wird auf die Verschlüsselung dieses Kanals verzichtet, ist das 
Abhören (sniffen) der IP-Pakete möglich.

Die Verschlüsselung ist optional und kann geringfügige Performanceverluste 
durch erhöhtes Datenaufkommen hervorrufen.

Video-Kanal: Über diesen Kanal wird das Videosignal des Zielrechners an die 
Software IP-Console Client übertragen.

Wird auf die Verschlüsselung dieses Kanals verzichtet, kann das 
übertragene Bild des Zielrechners durch abgehörte IP-Pakete wie-
derhergestellt werden.

Die Verschlüsselung ist optional und kann geringfügige Performanceverluste 
durch erhöhtes Datenaufkommen hervorrufen.
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Bandbreite

Wird ein neues Profil erstellt, wird die Funktion Bandbreitenmessung (s. Seite 18) 
automatisch aktiviert.

Diese Funktion ermittelt während des Verbindungsaufbaus die Bandbreite der Ver-
bindung zwischen dem KVM-Matrixsystem und dem lokalen Computer, auf wel-
chem die Software IP-Console Client eingesetzt wird.

Der ermittelte Wert wird anschließend im Rahmen der Aufbereitung und Übertra-
gung der Videoinformationen angewendet.

 Alternativ zur Bandbreitenmessung beim Verbindungsaufbau können Sie eine der 
aufgelisteten Bandbreiten fest vorgeben.

HINWEIS: Die zur Verfügung stehende Bandbreite innerhalb eines IP-Netzwerkes 
kann sich – je nach Auslastung des Netzwerkes – ändern. Dies kann zu einem 
Performanceverlust führen.

Führen Sie ggf. eine erneute Bandbreitenmessung (s. Seite 45) während der Sit-
zung durch, falls Sie einen Performanceverlust feststellen.

TIPP: Der festgelegte Wert kann während einer Sitzung durch Durchführung einer 
Bandbreitenmessung (s. Seite 45) angepasst werden.
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Erstinbetriebnahmemodus
Beim ersten Start der Software IP-Console Client wird der Erstinbetriebnahmemodus
gestartet.

In diesem Modus werden alle eingeschalteten Zielrechner des KVM-Matrixsystems 
nacheinander aufgeschaltet. Hierbei wird ein Videoprofil jedes Zielrechners erstellt, in 
welchem die Bildlage, die Phasenverschiebung und die Farbwerte gespeichert werden.

Der Fortschritt der Erstellung der Videoprofile wird im Assistenten angezeigt. Die 
Dauer der Ausführung des Assistenten hängt von der Anzahl der Zielrechner ab.

Manueller Start des Erstinbetriebnahmemodus
Wurde der Erstinbetriebnahmemodus während des ersten Starts der Software abge-
brochen, kann die erneute Ausführung jederzeit gestartet werden.

So starten Sie den Erstinbetriebnahmemodus manuell:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf System > Inbetriebnahmemodus.

3. Folgen Sie den Anweisungen des Erstinbetriebname-Assistenten.

HINWEIS: Folgen Sie den Anweisungen des Erstinbetriebname-Assistenten.

TIPP: Sie können den Erstinbetriebnahmemodus jederzeit abbrechen.

Die Videoprofile der Zielrechner, die aufgrund des vorzeitigen Abbruchs nicht erstellt 
werden konnten, werden bei der ersten Aufschaltung erstellt und gespeichert.
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Verbindungsaufbau
Während des Verbindungsaufbaus einer Sitzung erscheint auf Ihrem Bildschirm ein 
Fenster, welches Sie über den aktuellen Status des Verbindungsaufbaus informiert:

In diesem Fenster werden (von oben nach unten) folgende Informationen angezeigt:

 Fortschrittsbalken: Hier können Sie den aktuellen Fortschritt des Anmeldevorgangs 
erkennen. Die aktuell durchgeführte Aktion wird über dem Balken angezeigt.

 Kanal-Verschlüsselung: Die verschiedenen Kanäle und die angewendeten Ver-
schlüsselungen (s. Seite 15) werden angezeigt.

 Betriebsmodus: Zu Ihrer Information wird der aktuelle Betriebsmodus angezeigt.

Messung der Bandbreite
Wurde im aktiven Sitzungsprofil keine feste Bandbreite (s. Seite 16) vorgegeben, 
sondern die Bandbreitenmessung aktiviert, wird diese Messung während des Verbin-
dungsaufbaus durchgeführt.

Der ermittelte Wert der Messung wird anschließend im Rahmen der Aufbereitung 
und Übertragung der Videoinformationen angewendet.

HINWEIS: In Abhängigkeit vom Betriebsmodus sind möglicherweise einige der 
in diesem Handbuch beschriebenen Funktionen nicht verfügbar.

TIPP: Klicken Sie während der Bandbreitenmessung auf Erweitert, um eine grafische 
Darstellung der aktuellen gemessenen Bandbreite in Form einer Kurve anzuzeigen.

HINWEIS: Die zur Verfügung stehende Bandbreite innerhalb eines IP-Netzwerkes 
kann sich – je nach Auslastung des Netzwerkes – ändern. Dies kann zu einem 
Performanceverlust führen.

Führen Sie ggf. eine erneute Bandbreitenmessung (s. Seite 45) während der Sit-
zung durch, falls Sie einen Performanceverlust feststellen.
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Chat-Funktion
Die Software IP-Console Client kann auf mehreren Computern innerhalb des IP-Netz-
werkes installiert werden.

Die Chat-Funktion der Software ermöglicht dem Benutzer, der sich am System 
anmeldet, mit einem bereits angemeldeten Benutzer in Kontakt zu treten.

Beide Benutzer können innerhalb des Chats die weitere Vorgehensweise abstimmen.

So stimmen Sie die weitere Vorgehensweise bei bereits belegter Konsole inner-
halb eines Chats ab:

1. Starten Sie den Verbindungsaufbau (s. Seite 4).

2. Klicken Sie im Fenster auf Ja, um das Chat-Fenster zu öffnen.

3. Das Chat-Fenster wird auf Ihrem und dem Bildschirm des anderen Benutzers 
angezeigt.

4. Geben Sie Ihre Nachricht in das Eingabefeld ein und klicken Sie auf Senden oder 
betätigen Sie die Eingabetaste, um Ihre Nachricht an den anderen Benutzer zu 
versenden.

5. Die Anwort des anderen Benutzers wird im Textfeld im oberen Bereich des Fen-
sters angezeigt. Hierauf können Sie erneut, wie in Schritt 4. erläutert, antworten.

Die Chat-Kommunikation wird beendet, wenn der andere Benutzer Ihren Verbin-
dungswunsch ablehnt bzw. zustimmt oder Sie den Anmeldevorgang durch Klick 
auf Sitzung beenden abbrechen.

HINWEIS: Zur gleichen Zeit kann immer nur ein Benutzer auf einen IP-Arbeits-
platz des Systems zugreifen.

HINWEIS: Auf Ihrem Bildschirm erscheint ein Hinweis-Fenster, das über die 
Belegung der des IP-Arbeitsplatzes informiert und eine Verbindungsaufnahme 
mit dem anderen Benutzer anbietet.

WICHTIG: Wird innerhalb des Zeitfensters von 10 Sekunden keine Schaltfläche 
angeklickt, wird der Verbindungsaufbau automatisch abgebrochen.

HINWEIS: Wird der Verbindungsaufbau durch Klick auf Nein abgebrochen, 
wird wieder das Anmeldung-Fenster angezeigt.

HINWEIS: Gibt der andere Benutzer nicht innerhalb von 45 Sekunden eine Nach-
richt in das Textfenster ein oder klickt auf Ablehnen oder Sitzung beenden wird 
seine Sitzung automatisch beendet und Ihre Sitzung hergestellt.
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Das Steuerboard

Das Steuerboard ist die Bedienzentrale der Software IP-Console Client. Alle wichtigen 
Programmfunktionen sind über das Steuerboard erreichbar:

 Umschaltung zwischen den verfügbaren Zielrechnern
 Aufruf des On-Screen-Displays des KVM-Matrixsystems
 Ausführung von Tastatur-Makros
 Scrollen des sichtbaren Bildschirminhalts im Client-Fenster der Software
 Auswahl des darzustellenden Bildschirm-Ausschnittes des Zielrechners

Die Benutzeroberfläche
Auf der Benutzeroberfläche stehen Ihnen die nachfolgend aufgeführten Status-
Anzeigen und Werkzeuge zur Verfügung.

Status-Anzeige der Link-Verbindung

Im Feld Link Status wird der aktuelle Status der seriellen Verbindung 
zwischen der Software IP-Console Client und dem KVM-Matrixsystem 
angezeigt.

HINWEIS: Über die Link-Verbindung werden die im On-Screen-Display darzustel-
lenden Informationen und die Schaltzustände der Zielrechner an die Software 
übermittelt.
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Anzeige des Betriebsmodus der Software

Zu Ihrer Information wird der aktuelle Betriebsmodus angezeigt.

Menüleiste

Die Menüleiste zeigt die aktuell verfügbaren Befehle an (Aktion, Bearbeiten, Zielrechner
oder Makros, Video, System, Ansicht, Hilfe).

Filterfunktion

Mit der Filterfunktion oberhalb der Auflistung der Zielrechner können Sie die 
Anzeige der Zielrechner eingrenzen.

So grenzen Sie die Auflistung der Zielrechner mit der Filterfunktion ein:

1. Geben Sie im Textfeld eine beliebige Zeichenkette ein.

2. Auf dem Karteireiter Zielrechner werden daraufhin ausschließlich solche Rechner 
angezeigt, die die eingegebene Zeichenkette in der Spalte Zielrechner, Physikalische 
Adresse oder Kommentar enthalten.

Die Groß-/Kleinschreibung der Namen wird bei der Filterung ignoriert.

3. Um die Filterung aufzuheben, klicken Sie auf Löschen.

Link-Verbindung korrekt hergestellt.

Link-Verbindung gestört.

HINWEIS: In Abhängigkeit vom Betriebsmodus sind möglicher-
weise einige der beschriebenen Funktionen nicht verfügbar.

HINWEIS: Abhängig von der aktivierten Karteikarte des Steuerboards wird entwe-
der der Menüeintrag Zielrechner oder Makro angezeigt.
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Aufschaltung auf den zuletzt aktiven Zielrechner (Last Target)

Mit der Last Target-Funktion schalten Sie vom derzeit aktiven Zielrechner auf 
den zuletzt aufgeschalteten Zielrechner um.

So schalten Sie die Verbindung auf den zuletzt aufgeschalteten Zielrechner um:

1. Klicken Sie auf Last Target-Symbol neben dem Filterfeld.

Verschieben des Fensterausschnittes (Scrollen)

Ist die Bildschirmauflösung des Zielrechners größer als jene Ihres Computers, so 
kann nur ein Ausschnitt des Bildschirminhaltes des Zielrechners auf Ihrem Monitor 
angezeigt werden.

Über die Schaltflächen im Scrollen-Bereich des Steuerboards können Sie den darzustel-
lenden Ausschnitt auswählen. Weiterführende Informationen finden Sie im Abschnitt 
Verschieben des Fensterausschnittes (Scrollen) auf Seite 8.

Informationen der Statuszeile

In der Statuszeile werden folgende Informationen (von links nach rechts) angezeigt:

Karteikarten des Steuerboards

Den größten Teil des Steuerboards nehmen die Karteikarten in der Mitte des Fensters 
ein. Hier können Sie wahlweise die Karteikarten Zielrechner oder Makros anzeigen:

 Die Karteikarte Zielrechner enthält eine Auflistung der angeschlossenen Zielrechner.
Zu jedem Zielrechner werden folgende Informationen angezeigt:

HINWEIS: Wurde seit dem Start der Software IP-Console Client noch kein Zielrech-
ner aufgeschaltet oder ausschließlich auf dem aktuell aufgeschalteten Zielrechner 
gearbeitet, steht diese Funktion nicht zur Verfügung.

Bezeichnung des 
Videoprofils:

Bezeichnung des Videoprofils, welches dem aufgeschalteten 
Zielrechner zugeordnet wurde

Bildfrequenz: Anzahl der Bildaktualisierungen pro Sekunde die im Client-
Fenster dargestellt werden

Datentransferrate: Datentransferrate (in Kilobyte pro Sekunde) zwischen dem 
KVM-Matrixsystem und der Software IP-Console Client

Zielrechner: Bezeichnung des Zielrechners im KVM-Matrixsystem

Phys. Adr.: physikalische Adresse des Zielrechners

Status: Schaltzustand (An oder Aus) des Zielrechners

Zugriff: Zugriffsberechtigung auf den Zielrechner
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Die Symbole vor den Bezeichnungen der Zielrechner haben folgende Bedeutung:

 Die Karteikarte Makros ermöglicht das Ausführen von Tastaturmakros (s. Seite 34).

Darstellungsoptionen der Einträge der Karteikarten

Die Auflistung der Zielrechner bzw. Makros der Karteikarten können in folgenden 
Anzeigemodi betrachtet werden:

 Symbole: Anzeige großer Symbole und Angabe des Namens (übereinander)
 Liste: Anzeige kleiner Symbole und Angabe des Namens (nebeneinander)
 Details: Anzeige kleiner Symbole, Angabe des Namens sowie weiterer Informatio-

nen in Tabellenform

So ändern Sie den Anzeigemodi zur Darstellung der Zielrechner bzw. Makros:

1. Öffnen Sie ggf. das Steuerboard der Software.

2. Öffnen Sie das Ansicht-Menü.

3. Wählen Sie den Eintrag Symbole, Liste oder Details des Menüs.

Anzeige des On-Screen-Displays über das Steuerboard

Das On-Screen-Display (OSD) des KVM-Matrixsystems kann 
jederzeit im Client-Fenster angezeigt werden. Über das OSD ist die 
Bedienung und Konfiguration des Systems möglich.

Sie sind auf diesen Zielrechner aufgeschaltet.

Ein anderer Benutzer ist auf diesen Zielrechner aufgeschaltet.

Mehrere Benutzer sind auf diesen Zielrechner aufgeschaltet.

Der Zielrechner ist eingeschaltet ist (grüner Punkt).

Der Zielrechner ist ausgeschaltet (roter Punkt).

TIPP: Die anzuzeigenden Tastaturmakros können durch die Auswahl einer 
Gruppe (s. Seite 36) filtern.

HINWEIS: Da die Darstellung des On-Screen-Displays nicht vom KVM-Matrixsy-
stem, sondern von der Software IP-Console Client erstellt wird, ist die Änderung der 
Positionierung und die Synchronisationseinstellung nicht möglich!
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So zeigen Sie das On-Screen-Displays des Matrixsystems im Client-Fenster an:

1. Klicken Sie auf die Schaltfläche AdonIS.

Durchführbare Aktionen im Steuerboard

Steuerboard schließen

Schließen Sie das Steuerboard, um die Arbeit im Client-Fenster der Software fortzu-
setzen.

So schließen Sie das Steuerboard:

1. Klicken Sie im Menü auf Aktion > Steuerboard schließen.

Sitzung schließen

Beenden Sie die Sitzung mit dem KVM-Matrixsystem nach Abschluss Ihrer Arbeiten 
oder um beispielsweise einem anderen Benutzer die Verwendung des IP-Arbeitsplatz-
platzes zu ermöglichen.

So schließen Sie die Sitzung:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Aktion > Sitzung schließen.

Software beenden

So beenden Sie die Ausführung der Software auf Ihrem Computer:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Aktion > Beenden.

Umschaltung auf Vollbild-Modus des Client-Fensters

Ist auf dem Zielrechner und auf Ihrem lokalen Computer die gleiche Bildschirmauf-
lösung eingestellt, empfiehlt sich die Darstellung des Client-Fensters im Vollbild-
Modus.

In diesem Modus wird das Client-Fenster auf die vollständige Desktopgröße erwei-
tert, damit der komplette Bildschirm für das Bild des Zielrechners zur Verfügung 
steht.

TIPP: Während Ihrer Arbeit auf einem Zielrechner innerhalb des Client-Fensters 
können Sie das OSD durch Verwendung der Tastenkombination Strg+Num (Stan-
dard) des KVM-Matrixsystems aufrufen.

HINWEIS: Taskleisten und andere Bedienelemente auf Ihrem Desktop werden 
durch den Vollbild-Modus des Client-Fensters überdeckt.

Im Vollbild-Modus ist das Scrollen innerhalb des Client-Fensters nicht erforderlich.
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So schalten Sie das Client-Fenster in den Vollbild-Modus:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Video > Vollbild oder betätigen Sie die F11-Taste.

Skalierung des Videobildes des aufgeschalteten Rechners

Unterstützt der Rechner, auf dem Sie die Software IP-Console Client einsetzen, die 
Programmierschnittstelle OpenGL wird automatisch die Skalierung eingeschaltet.

Hierdurch wird das Bild des aufgeschalteten Rechners in das Client-Fenster einge-
passt, falls die Bildauflösung des aufgeschalteten Rechners größer als die Auflösung 
des Client-Fensters ist.

Die Skalierung können Sie manuell aus- und einschalten.

So schalten Sie die Skalierung manuell aus oder ein:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Video > Skalierung um den aktuellen Modus 
umzuschalten.

Kantenglättung des skalierten Videobildes (de)aktivieren

Bei skalierten Bildern kann sich der Treppeneffekt störend auf die Bildqualität aus-
wirken. Aktivieren Sie in diesem Fall die Kantenglättung. Hierdurch werden Kan-
ten zur angrenzenden Farbe im Bild so berechnet, dass diese keinen störenden 
Treppeneffekt bilden.

Die Kantenglättung können Sie nur ein- oder ausschalten, wenn die Skalierung ein-
geschaltet ist.

So schalten Sie die Kantenglättung ein oder aus:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Video > Kantenglättung um den aktuellen Modus 
umzuschalten.

HINWEIS: Auf Rechnern, die die Programmierschnittstelle OpenGL (Open Gra-
phics Library) nicht unterstützen, sind die Funktionen Skalierung und Kantenglät-
tung nicht einsetzbar.

HINWEIS: Ist die Funktion aktiviert, erscheint neben dem Menüpunkt eine 
Markierung.

HINWEIS: Ist die Funktion aktiviert, erscheint neben dem Menüpunkt eine 
Markierung.
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Einfügen des Inhalts der Zwischenablage

Kopieren Sie auf dem lokalen Computer einen beliebigen Text in die Zwischen-
ablage, können Sie diesen innerhalb des Client-Fensters einfügen.

So fügen Sie in den Inhalt der Zwischenablage innerhalb des Client-Fensters ein:

1. Öffnen Sie ggf. das Steuerboard der Software.

2. Klicken Sie im Menü auf Bearbeiten > Einfügen (DE).

Bildschirmfoto

Beispielweise zu Dokumentationszwecken können Sie mit der Software ein Bild-
schirmfoto (Screenshot) der Bildschirmansicht des Zielrechners im Client-Fenster 
erstellen.

So erstellen Sie ein Bildschirmfoto der Bildschirmansicht des Zielrechners:

1. Öffnen Sie ggf. das Steuerboard der Software.

2. Klicken Sie im Menü auf Video > Bildschirmfoto.

3. Wählen Sie den gewünschten Speicherort und Dateityp (*.png oder *.bmp).

4. Geben Sie den gewünschten Dateinamen ein und klicken Sie auf Speichern.

Position der Statuszeile festlegen

Die Statuszeile des Client-Fensters kann wahlweise am oberen (Standard) oder am 
unteren Fensterrand angezeigt werden.

So bestimmen Sie die Position der Statuszeile des Client-Fenster:

1. Öffnen Sie ggf. das Steuerboard der Software.

2. Klicken Sie im Menü auf Ansicht > Statuszeile > Oberer Fensterrand oder alternativ 
Ansicht > Statuszeile > Unterer Fensterrand.

TIPP: Stimmt das Tastaturlayout des Zielrechners nicht mit der gewählten 
Sprachversion der Software IP-Console Client überein, können Sie über den Ein-
trag Bearbeiten > Einfügen erweitert > Einfügen (EN) das Layout auf die gewünschte 
Sprache abändern.
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Videoprofile
Wie im Kapitel Erstinbetriebnahmemodus auf Seite 17 beschrieben, wird im Rahmen 
dieses Modus oder beim ersten Aufschalten auf einen Zielrechner ein Videoprofil 
erstellt und gespeichert.

Jedes Videoprofil hat eine individuelle Bezeichnung. Der Grundaufbau der von der 
Software erstellten und vom Benutzer editierbaren Bezeichnungen hat folgende Syntax:

 [Bildpunkte_horizontal]×[Bildpunkte_vertikal]@[Wiederholfrequenz_vertikal]

Detailinformationen der Videoprofile

Anzeige der Detailinformationen

So rufen Sie die Einstellungen des aktuellen Videoprofils auf:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüleiste auf Video > Videoeinstellungen > Aktuelles Profil bearbei-
ten.

So rufen Sie die Einstellungen eines beliebigen Videoprofils auf:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Zielrechner.

3. Klicken Sie mit der rechten Maustaste auf einen Zielrechner und anschließend 
auf Eigenschaften.

4. Klicken Sie auf den Reiter Videoprofile.

HINWEIS: Videoprofilen, die im Rahmen der ersten Aufschaltung auf einen Ziel-
rechner – ohne Ermittlung der Farbwerte – erstellt wurden, wird die Zeichenfolge 
Auto- vorangestellt.

Wurde ein Videoprofil im Rahmen des Erstinbetriebnahmemodus bzw. mit der Funk-
tion Videoprofil erstellen erstellt, wird diesem die Zeichenfolge EIM- vorangestellt.

TIPP: Die aktuellen Messwerte des Videosignals (Art der Synchronisation, Bild-
wiederholrate und Bildhöhe) können Sie über das Menü Video > Videoeinstellungen 
> Anzeigen des Steuerboards einsehen.
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Erläuterung der Karteikarte »Videoprofile«

Die Karteikarte Videoprofile ist in zwei Bereiche unterteilt:

 Aktives Profil: Anzeige des aktuell angewendeten Videoprofils
 Weitere Profile: Anzeige weiterer, für diesen Zielrechner erstellte, Videoprofile

Zu jedem Videoprofil werden Ihnen folgende Informationen angezeigt:

HINWEIS: Die Boot-Phase, der Anmeldevorgang am Betriebssystem und die Dar-
stellung der Arbeitsoberfläche der Zielrechner werden häufig mit unterschiedli-
chen Auflösungen am Bildschirm dargestellt.

Aufgrund der unterschiedlichen Videoeigenschaften werden in diesen Fällen 
separate Videoprofile angezeigt.

WICHTIG: Auch Videoprofile nicht aufgeschalteter Zielrechner können angesehen, 
bearbeitet oder gelöscht werden.

Im oberen Fensterbereich sehen Sie immer das Profil des aktuell aufgeschalteten
Zielrechners. Im unteren Fensterbereich werden alle verfügbaren Videoprofile des 
ausgewählten Zielrechners aufgelistet.

Name: Bezeichnung des Videoprofils

Auflösung: horizontale und vertikale Auflösung sowie vertikale Wiederholfre-
quenz des Videoprofils

Quelle: Anzeige durch welche „Quelle“ das Profil erstellt wurde:

 Auto: Videoprofil wurde bei der ersten Aufschaltung auf einen Ziel-
rechner erstellt

 C-Auto: Videoprofil wurde im Rahmen des Erstinbetriebnahmemodus 
bzw. mit der Funktion Videoprofil erstellen erstellt

 User: Einstellungen und/oder Bezeichnung des Videoprofils wur-
den vom Benutzer editiert
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Videoprofile erstellen und bearbeiten

Erstellung eines neuen Videoprofils

Wie im Kapitel Erstinbetriebnahmemodus auf Seite 17 beschrieben, wird im Rahmen 
dieses Modus ein vollständige Videoprofil (inkl. Ermittlung der Farbwerte) erstellt 
und gespeichert.

So erstellen Sie ein Videoprofil für einen bestimmten Zielrechner:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Zielrechner.

3. Doppelklicken Sie auf einen Zielrechner, um sich auf diesen aufzuschalten.

4. Klicken Sie im Menü auch Video > Videoprofil erstellen.

Änderung eines Videoprofils

Alle Daten des Videoprofils (Bildlage, die Phasenverschiebung und die Farbwerte) kön-
nen durch den Benutzer editiert und angepasst werden.

So ändern Sie die Einstellungen des aktuellen Videoprofils:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüleiste auf Video > Videoeinstellungen > Aktuelles Profil bearbei-
ten.

3. Ändern Sie die gewünschte(n) Einstellung(en) des Videoprofils (s. Seite 30 f.).

4. Klicken Sie auf Speichern, um die Einstellungen zu speichern oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.

So ändern Sie die Einstellungen eines beliebigen Videoprofils:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Zielrechner.

3. Klicken Sie mit der rechten Maustaste auf einen Zielrechner und anschließend 
auf Eigenschaften.

4. Klicken Sie auf den Reiter Videoprofile.

5. Wählen Sie das zu editierende Videoprofil im Abschnitt Aktives Profil oder Weitere 
Profile.

HINWEIS: Wurde der Erstinbetriebnahmemodus während des ersten Starts der 
Software abgebrochen und anschließend nicht erneut durchgeführt, ist möglicher-
weise kein vollständiges Videoprofil eines Zielrechners verfügbar.

HINWEIS: Der Menüpunkt ist ausschließlich anwählbar, wenn das Videoprofil 
noch nicht erstellt wurde!
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6. Klicken Sie auf Bearbeiten.

7. Ändern Sie die gewünschte(n) Einstellung(en) des Videoprofils (s. Seite 30 f.).

8. Klicken Sie auf Speichern, um das Einstellungen zu speichern oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.

Löschung eines Videoprofils

So löschen Sie ein Videoprofils:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Zielrechner.

3. Klicken Sie mit der rechten Maustaste auf einen Zielrechner und anschließend 
auf Eigenschaften.

4. Klicken Sie auf den Reiter Videoprofile.

5. Wählen Sie das zu löschende Videoprofil im Abschnitt Aktives Profil oder Weitere 
Profile.

6. Klicken Sie auf Löschen.

Einstellungsoptionen
Die Videoeinstellungen des Profils können vom Benutzer editiert werden. Auf den 
folgenden Seiten werden die möglichen Einstellungen auf den verschiedenen Kartei-
karten des Fensters erläutert.

Der untere Bereich des Fensters ist auf allen Karteikarten identisch:

Links unten wird die Anzahl der Bildaktualisierungen pro Sekunde im Client-Fen-
ster (Bildfrequenz) sowie die Datentransferrate (in Kilobyte pro Sekunde) zwischen 
dem Matrixsystem und der Software IP-Console Client angezeigt.

Zusätzlich finden Sie hier folgende Bedienelemente:

HINWEIS: Wird das aktive Videoprofil gelöscht, erstellt die Software automatisch 
ein neues Videoprofil.

direkt anzeigen: Änderungen an den Einstellungen werden sofort auf die Bildan-
zeige im Client-Fenster angewendet

Testen: Änderungen an den Einstellungen auf die Bildanzeige im Client-
Fenster anwenden

Neu zeichnen: Synchronisierung des übertragenen Bildes des Zielrechners



Videoprofile
31 · G&D IP-Console Client

Bestimmen von Bildbreite, -lage und -größe

Auf der Karteikarte Bild haben Sie die Möglichkeit, die Bildbreite, -lage und -größe 
festzulegen.

Folgende Einstellungen können von Ihnen individuell optimiert werden:

Abbrechen: Änderungen an den Einstellungen verwerfen und Dialog schließen

Schließen: Temporäre Speicherung der Einstellungen bis zum erneuten 
Aufschalten des Zielrechners

Speichern: Speicherung der Einstellungen

Rückgängig: Änderungen seit dem letzten Speichern verwerfen

TIPP: Möchten Sie die auf dieser Karteikarte editierbaren Einstellungen automa-
tisch ermitteln lassen, klicken Sie auf Bildlageerkennung.

Folgende Voraussetzungen sind zu verlässlichen Ausführung der Funktion erfor-
derlich:

 Die Bildschirmauflösung des Zielrechners ist kleiner als jene des Client-Fensters.
 Die Einstellung der Ränder des aktuell aufgeschalteten Zielrechners liegen inner-

halb einer errechneten Größe (abhängig von der jeweiligen Bildauflösung).

Bildbreite: Breite des Bildes (inkl. der Schwarzschulter) in Pixel

Die Bildbreite ist immer größer als die Breite des tatsächlich sichtbaren 
Bildbereiches!

Vertikale 
Bildlage:

Pixel (vertikal) ab welchem das Bild beginnt

Vertikale 
Bildgröße:

Höhe des sichtbaren Bildbereiches

Bei der Einstellung der Bildhöhe können Sie sich an den üblichen Bild-
schirmauflösungen orientieren (z. B. 1024 × 768).

Stellen Sie die Bildhöhe so ein, dass oben kein schwarzer Rand verbleibt 
und das Bild vollständig sichtbar ist.

Horizontale 
Bildlage:

Pixel (horizontal) ab welchem das Bild beginnt

Horizontale 
Bildgröße:

Breite des sichtbaren Bildbereiches

Bei der Einstellung der Bildbreite können Sie sich an den üblichen Bild-
schirmauflösungen orientieren (z. B. 1024 × 768).

Stellen Sie die Bildlage so ein, dass links kein schwarzer Rand verbleibt 
und das Bild vollständig sichtbar ist.
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So ändern Sie die vorbelegten Werte:

1. Ändern Sie die gewünschten Werte in den verschiedenen Eingabefeldern.

Hierbei ist es empfehlenswert, die numerischen Werte nicht direkt über die 
Tastatur einzugeben, sondern die Pfeiltasten zu verwenden.

Bestimmen der Farbwerte

Auf der Karteikarte Farben können Sie Farbwerte und die Helligkeit des Bildes indi-
viduell einstellen.

Folgende Einstellungen können von Ihnen individuell optimiert werden:

So ändern Sie die vorbelegten Werte:

1. Verwenden Sie die Schieberegler, um die Farbwerte und die Helligkeit einzustellen.

Alternativ können Sie die gewünschten Werte direkt in den entsprechenden Ein-
gabefeldern erfassen.

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 30) aktiviert, können Sie 
die Einstellungen komfortabel ändern und gleichzeitig die Auswirkung im Cli-
ent-Fenster betrachten.

HINWEIS: Klicken Sie auf Rückgängig, um die ursprünglichen Werte dieses Rei-
ters wieder zu aktivieren. 

TIPP: Möchten Sie die auf dieser Karteikarte editierbaren Einstellungen automa-
tisch ermitteln lassen, klicken Sie auf Auto-Farbeinstellung.

Rot: Einstellung des Farbwertes der Farbe rot

Grün: Einstellung des Farbwertes der Farbe grün

Blau: Einstellung des Farbwertes der Farbe blau

Farbregler 
synchronisieren:

Aktivieren Sie diese Option, wenn Sie den Kontrast verstellen 
wollen. Bei der Änderung eines Farbwertes werden die Werte 
der beiden anderen Farben ebenfalls angepasst.

Ist die Funktion deaktiviert (Standard) können Sie die Gewich-
tung der einzelnen Farben verändern, beispielsweise um einen 
Farbstich im Bild zu korrigieren.

Helligkeit: Einstellung der Grundhelligkeit des Bildes

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 30) aktiviert, können Sie 
die Einstellungen komfortabel ändern und gleichzeitig die Auswirkung im Cli-
ent-Fenster betrachten.

HINWEIS: Klicken Sie auf Rückgängig, um die ursprünglichen Werte dieses Rei-
ters wieder zu aktivieren. 



Videoprofile
33 · G&D IP-Console Client

Einstellung der Phasenlage

Die Einstellung der Phasenlage ist eine wesentliche Einstellung für die korrekte Ver-
arbeitung des Videosignals.

So ändern Sie die vorbelegte Phaseneinstellung:

1. Wählen Sie im Abschnitt Einstellung die Option manuell.

2. Stellen Sie den gewünschten Wert ein.

Hierbei ist es empfehlenswert, die numerischen Werte nicht direkt über die 
Tastatur einzugeben, sondern die Pfeiltasten zu verwenden.

3. Optional: Aktivieren Sie falls gewünscht die Option Rauschunterdrückung.

TIPP: Die Funktion Autophase übernimmt die Phaseneinstellung für den Benutzer.

Zur korrekten Ausführung der Funktion ist die Ausgabe eines statischen Bildes 
(beispielsweise des Desktops) durch den Zielrechner erforderlich.

Ist auf dem Zielrechner ein Bildschirmschoner aktiv, kann die Funktion nicht 
durchgeführt werden!

TIPP: Zeigen Sie auf dem Zielrechner möglichst ein Bild mit senkrechter 
Schraffur oder vielen senkrechten Linien an und optimieren Sie den Phasen-
Wert so, dass die Linien gleichmäßig und scharf dargestellt werden.

TIPP: Haben Sie die Funktion direkt anzeigen (s. Seite 30) aktiviert, können Sie die 
Einstellungen komfortabel ändern und gleichzeitig die Auswirkung im Client-
Fenster betrachten.

HINWEIS: Klicken Sie auf Rückgängig, um die ursprünglichen Werte dieses Rei-
ters wieder zu aktivieren. 
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Tastaturmakros
Viele Benutzer verwenden Tastaturbefehle zur schnellen und effizienten Bedienung 
des Betriebssystems oder der Anwendungssoftware.

Bei der Bedienung der Zielrechner über den IP-Arbeitsplatz des KVM-Matrixsy-
stems befinden sich drei Geräte in der Kommunikationsstrecke: der Zielrechner, der 
Matrixswitch und der lokale Computer auf dem die Software IP-Console Client betrie-
ben wird.

Verwenden Sie die in diesem Kapitel beschriebenen Tastaturmakros des Steuer-
boards, um die Weiterleitung der Tastenkombinationen an den Zielrechner sicher-
zustellen.

Ausführen eines Tastaturmakros
Die Tastaturmakros können wahlweise über das Steuerboard oder mit den – in den 
Einstellungen der Tastaturmakros – gewählten Tastenkombinationen ausgeführt 
werden.

So führen Sie ein Tastaturmakro über das Steuerboard aus:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Doppelklicken Sie auf das auszuführende Makro.

So führen Sie ein Tastaturmakro mit einer Tastenkombination aus:

1. Klicken Sie ggf. in das Client-Fenster, um dieses zu aktivieren.

2. Betätigen Sie die Tastenkombination Strg+Shift und die dem auszuführenden 
Tastaturmakro zugeordnete F-Taste.

WICHTIG: Betätigen Sie eine Tastenkombination (beispielsweise Strg+Alt+Entf), 
wird diese vom lokalen Computer interpretiert und somit nicht zum Zielrechner 
übertragen.
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Verwaltung von Tastaturmakros

Erstellen von Tastaturmakros

So erstellen Sie ein neues Tastaturmakro:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Klicken Sie in der Menüzeile auf Makros > Neu.

4. Geben Sie im Feld Name die Bezeichnung des zu erstellenden Makros ein.

5. Klicken Sie auf einen Reiter oberhalb der virtuellen Tastatur zur Auswahl des 
gewünschten Tastatur-Layouts (PC-Tastatur oder SUN-Tastatur) und der Sprach-
variante.

6. Geben Sie über die virtuelle Tastatur die gewünschte Tastenfolge ein.

7. Optional: Klicken Sie auf Gruppen-Zuordnung bearbeiten, um das neue Makro beliebig 
vielen Gruppen (s. Seite 36) zuordnen.

Markieren Sie mit der Maus eine oder mehrere Gruppen, in die Sie das neu 
erstellte Makro einsortieren möchten.

8. Optional: Möchten Sie das Tastaturmakro über eine Tastenkombination ausfüh-
ren, wählen Sie im Tastaturkürzel eine beliebige F-Taste aus.

TIPP: Der Wechsel zwischen den Layouts ist auch während der Eingabe möglich.

HINWEIS: Klicken Sie auf eine virtuelle Taste, wird dies als Betätigung und 
Halten der Taste interpretiert und durch die Änderung der Schraffur angezeigt.

Im Feld Tastenfolge wird die Kurzbezeichnung dieser Taste und im Feld Scancode
der entsprechende Tastencode eingetragen.

TIPP: Klicken Sie auf Löschen oder Alle Löschen um die letzte oder alle Tastenbe-
tätigungen rückgängig zu machen.

BEISPIEL: Möchten Sie ein Tastaturmakro für die Tastenkobination Strg+C
erstellen, klicken Sie zunächst auf die linke Strg-Taste und anschließend auf C.

Beim Verlassen des Dialogs werden automatisch die Tastenfolgen zum Lösen 
der gedrückten Tasten – in umgekehrter Reihenfolge – erstellt und hinzugefügt.

HINWEIS: Alle neuen Makros werden stets der Gruppe Alle zugeordnet.

TIPP: Halten Sie während einer Mehrfach-Selektierung die Strg-Taste gedrückt. 

HINWEIS: Bereits bei anderen Tastaturmakros verwendete F-Tasten werden 
hier nicht mehr aufgeführt.
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9. Klicken Sie auf OK, um das neue Tastaturmakro zu erstellen oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.

Bearbeiten von Tastaturmakros

So bearbeiten Sie ein bereits definiertes Tastaturmakro:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Klicken Sie mit der rechten Maustaste auf das zu editierende Makro und 
anschließend auf Bearbeiten im Kontextmenü.

4. Ändern Sie die gewünschten Eigenschaften des Tastaturmakros.

Löschen von Tastaturmakros

So löschen Sie ein bereits definiertes Tastaturmakro:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Klicken Sie mit der rechten Maustaste auf das zu löschende Makro und anschlie-
ßend auf Löschen im Kontextmenü.

Die Makro-Gruppen
Um auch bei einer Vielzahl von Makros schnell das gewünschte Makro zu finden, 
können die einzelnen Makros in Gruppen organisiert werden.

Filterung der Makros anhand einer Gruppe

So grenzen Sie die auf dem Reiter Makros anzuzeigenden Tastaturmakros ein:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Wählen Sie im Feld Makro-Gruppe die Gruppe aus, deren Makros aufgelistet wer-
den sollen.

HINWEIS: Beschreibungen der verschiedenen Einstellungen finden Sie im Abschnitt 
Erstellen von Tastaturmakros auf Seite 35.

HINWEIS: In der Standardkonfiguration sind die Gruppen Linux, Novell, G&D Hot-
keys, SUN, VMWare, Windows und special keys angelegt.

TIPP: Haben Sie die Makrogruppe Favoriten angelegt, werden beim erstmaligen 
Aufruf der Karteikarte Makros innerhalb einer Sitzung die Makros dieser Gruppe 
angezeigt.
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Erstellung einer neuen Makrogruppe

So erstellen Sie eine neue Makrogruppe:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Klicken Sie mit der rechten Maustaste auf einen Freiraum in der Auflistung der 
Makros und anschließend auf Gruppen bearbeiten im Kontextmenü.

4. Klicken Sie auf Neue Gruppe.

5. Geben Sie den gewünschten Namen der Gruppe ein.

6. Klicken Sie auf OK, um die neue Gruppe zu erstellen oder verwerfen Sie Ihre Ein-
gaben durch Klick auf Abbrechen.

Umbenennung einer Makrogruppe

So ändern Sie den Namen einer Makrogruppe:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Klicken Sie mit der rechten Maustaste auf einen Freiraum in der Auflistung der 
Makros und anschließend auf Gruppen bearbeiten im Kontextmenü.

4. Klicken Sie auf die umzubenennende Gruppe und anschließend auf Bearbeiten.

5. Geben Sie den gewünschten Namen der Gruppe ein.

6. Klicken Sie auf OK, um die Gruppe umzubenennen oder verwerfen Sie Ihre Ein-
gaben durch Klick auf Abbrechen.

Löschen einer Makrogruppe

So löschen Sie eine Makrogruppe:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie ggf. auf den Reiter Makros.

3. Klicken Sie mit der rechten Maustaste auf einen Freiraum in der Auflistung der 
Makros und anschließend auf Gruppen bearbeiten im Kontextmenü.

4. Klicken Sie auf die zu löschende Gruppe und anschließend auf Löschen.

5. Klicken Sie auf OK, um die Änderungen zu speichern oder verwerfen Sie die 
Änderungen durch Klick auf Abbrechen.
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Videofunktionen
Automatische Größenanpassung des Client-Fensters (AutoFit)

Die automatische Größenanpassung passt die Größe des Client-Fensters bei jedem 
Aufschaltvorgang an die aktuelle Auflösung des Zielrechners an.

Ist die Bildschirmauflösung des Zielrechners größer als jene Ihres Computers, so 
können Sie den anzuzeigenden Bildschirmausschnitt im Client-Fenster verschieben 
(s. Seite 8).

So ändern Sie die Einstellungen der AutoFit-Funktion in den erweiterten Sit-
zungseinstellungen:

1. Klicken Sie im Anmeldung-Fenster links unten auf Erweitert.

2. In der Standardeinstellung ist die AutoFit-Funktion aktiviert und die Option Auto-
Fit deaktiviert ausgeschaltet.

Möchten Sie die Funktion deaktivieren, aktivieren Sie Option Autofit deaktiviert 
und geben eine feste Breite und Höhe des Client-Fensters (in Bildpunkten) ein.

3. Klicken Sie auf OK, um die Änderungen zu speichern oder verwerfen Sie die 
Änderungen durch Klick auf Abbrechen.

So (de)aktivieren Sie die AutoFit-Funktion über das Video-Menü:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg + Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > AutoFit.

TIPP: Für einen optimalen Bedienkomfort ist es empfehlenswert, die Auflösung 
Ihres lokalen Computers höher einzustellen als die des Zielrechners.

HINWEIS: Die Autofit-Funktionen können Sie in den erweiterten Sitzungseinstel-
lungen sowie über das Video-Menü einstellen.

HINWEIS: Verändern Sie während einer Sitzung die Größe des Client-Fensters, 
gilt diese Änderung nur für die Dauer der Sitzung.

Nach einem erneuten Start gilt erneut die hier getroffene Größendefinition.

HINWEIS: Ist die Funktion aktiviert, erscheint neben dem Menüpunkt eine 
Markierung.
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Manuelle Größenanpassung des Client-Fensters (Fit Profil)

Im Auslieferungszustand garantiert die AutoFit-Funktion (s. letzter Abschnitt), dass 
sich die Größe des Client-Fensters an der Auflösung des aufgeschalteten Zielrech-
ners orientiert.

Haben Sie die Größe des Client-Fensters manuell geändert, ist die Funktion AutoFit
deaktiviert. Schalten Sie sich nun auf einen anderen Zielrechner auf, wird die Größe 
des Client-Fensters nicht angepasst.

Mit der Fit Profil-Funktion wird das Client-Fenster an die Auflösung des aktuell auf-
geschalteten Zielrechners angepasst.

So passen Sie die Größe des Client-Fensters an den aktuall aufgeschalteten Ziel-
rechner an:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Fit Profil.

Erneute Übertragung des vollständigen Bildschirminhaltes

Mit der Funktion Bild neu zeichnen erreichen Sie eine vollständige Übertragung des 
gesamten Bildschirminhaltes. Eventuell auftretende Bildartefakte werden durch die 
erneute Übertragung beseitigt.

So erreichen Sie die vollständige Übertragung und Darstellung des Bildes:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg + Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Bild neu zeichnen.

Erneute Übertragung und Phasen-Erkennung des Bildes

Mit der Funktion Bild neu synchronisieren erreichen Sie eine vollständige Übertragung 
des gesamten Bildschirminhaltes sowie die automatische Phasen-Erkennung.

So erreichen Sie die vollständige Synchronisierung des Bildes:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Bild neu synchronisieren.

WICHTIG:  Diese Anpassung gilt im Gegensatz zur AutoFit-Funktion nur für den 
aktuell aufgeschalteten Zielrechner.

TIPP: Diese Funktion können Sie alternativ mit der F5-Taste aktivieren, wenn das 
Steuerboard aktiv ist.



Videofunktionen
G&D IP-Console Client · 40

Automatische Erkennung der Phasenlage

Mit der Funktion Autophase führen Sie eine automatische Erkennung der Phasenlage 
durch. 

So führen Sie die automatische Phasen-Erkennung durch:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Autophase.

Automatische Bestimmung der Farbwerte

Mit der Funktion Auto-Farbeinstellung wird die automatische Bestimmung der Farb-
werte des Zielrechners ausgeführt.

So führen Sie die automatische Bestimmung der Farbwerte durch:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Auto-Farbeinstellung.

Automatische Erkennung der Bildlage

Mit der Funktion Bildlageerkennung wird die automatische Erkennung der Bildlage 
des Zielrechners ausgeführt.

So führen Sie die Erkennung der Bildlage durch:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf Video > Videoeinstellungen > Bildlageerkennung.
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Mausgesten
Die Mausgesten ermöglichen das Auslösen der Maus aus dem Client-Fenster (s. Seite 8) 
und das Öffnen des Steuerboards (s. Seite 20) durch die Ausführung von vorkonfigurier-
ten Mausbewerungen:

Verwendung von Mausgesten
Ist die Bedienung des On-Screen-Displays des KVM-Matrixsystems bzw. des Ziel-
rechners innerhalb des Client-Fensters aktiv, wird in der eckigen Klammer Bedienung 
aktiv angezeigt.

So verwenden Sie eine Mausgeste:

 Bewegen Sie die Maus – in schneller Abfolge – in die Richtungen der Mausgeste.

Mausgesten aktivieren
Die Unterstützung von Mausgestern kann vor dem Verbindungsaufbau (über den 
Anmeldung-Dialog) oder während der Sitzung (über das Steuerboard) eingestellt werden.

So (de)aktivieren Sie Anwendung von Mausgesten vor dem Verbindungsaufbau:

1. Klicken Sie links unten im Anmeldung-Dialog auf Erweitert.

2. Aktivieren oder deaktivieren Sie die Option Mausgesten aktiviert.

3. Klicken Sie auf OK, um die Einstellungen anzuwenden oder verwerfen Sie Ihre 
Eingaben durch Klick auf Abbrechen.

So (de)aktivieren Sie die Anwendung von Mausgesten innerhalb einer Sitzung:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf System > Mausgesten aktivieren, um die derzeitige Einstel-
lung umzukehren.

Mausgeste Funktion

links-rechts-links Auslösen der Maus aus dem Client-Fenster

hoch-runter-hoch Öffnen des Steuerboards

WICHTIG: Ausschließlich in diesem Status können Sie eine Mausgeste ausführen.

TIPP: Konfigurieren Sie gegebenfalls die vorgegebenen Zeiten zur Auslösung der 
Mausgesten (s. Seite 42).

HINWEIS: Ist die Funktion aktiviert, erscheint neben dem Menüpunkt eine 
Markierung.
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Zeitspanne zur Erkennung der Mausgesten 
konfigurieren
Wird die Bewegung der Maus – in schneller Abfolge – in die vorkonfigurierten 
Richtungen einer Mausgeste erkannt, wird die zugeordnete Funktion ausgeführt.

Stellen Sie die Geschwindigkeit zur Ausführung der Funktionen der Mausgesten so ein, 
dass Sie zuverlässig die gewünschte Aktion durch eine Mausgeste auslösen können.

So legen Sie die Zeitspanne zur Erkennung der Mausgesten fest:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf System > Mausgesten konfigurieren.

3. Stellen Sie die Zeitspanne zur Erkennung der einzelnen Mausgesten über die ver-
schiedenen Regler so ein, dass Sie zuverlässig die gewünschte Aktion durch eine 
Mausgeste auslösen können.

4. Klicken Sie auf Speichern, um die Einstellungen zu speichern oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.
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Mausbremse
Viele Betriebssysteme bieten den Benutzern eine so genannte Mausbeschleunigung an.

Wenn sowohl auf Ihrem lokalen Computer als auch auf dem Zielrechner eine Maus-
beschleunigung durchgeführt wird, hat dies zur Folge, dass sich der Mauszeiger auf 
dem Zielrechner sehr schnell bewegt und hierdurch die Bedienung erschwert.

Unterschied zwischen globaler und individueller 
Mausbremse
Bei der Aktivierung der Mausbremse können Sie zwischen der globalen und der 
indivuellen Mausbremse wählen.

 globale Mausbremse: Aktivierung der Mausbremse für alle Zielrechner des Systems
 individuelle Mausbremse: Aktivierung der Mausbremse für den aktuell aufgeschalte-

ten Zielrechner

Mausbremse aktivieren
Die Anwendung der Mausbremse kann vor dem Verbindungsaufbau (über den Anmel-
dung-Dialog) oder während der Sitzung (über das Steuerboard) eingestellt werden.

So (de)aktivieren Sie die Anwendung der globalen Mausbremse vor dem Verbin-
dungsaufbau:

1. Klicken Sie links unten im Anmeldung-Dialog auf Erweitert.

2. Aktivieren oder deaktivieren Sie die Option Mausbremse global aktiviert.

3. Klicken Sie auf OK, um die Einstellungen anzuwenden oder verwerfen Sie Ihre 
Eingaben durch Klick auf Abbrechen.

HINWEIS: Die Mausbeschleunigung der Betriebssysteme wertet neben der Strecke, 
die die Maus verschoben wird, auch die Dauer der Bewegung aus.

Bei „langen“ Bewegungen wird die Bewegung des Mauszeigers auf dem Bild-
schirm beschleunigt.

HINWEIS: Bei Aktivierung einer der beiden Varianten der Mausbremse wird bei 
Zielrechnern, deren Beschleunigungswert bereits eingestellt wurde, diese Einstel-
lung angewendet.

Bei Zielrechnern, deren Beschleunigungswert noch nicht konfiguriert wurde, wird 
der Standardwert angewendet.

HINWEIS: Die globale Einstellung kann auch über die im folgenden Abschnitt 
erläuterte Anweisung erfolgen.
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So (de)aktivieren Sie die Anwendung der globalen oder indivduellen Mausbremse 
innerhalb einer Sitzung:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf System > Mausbremse konfigurieren.

3. Aktivieren oder deaktivieren Sie die Optionen Mausbremse aktivieren bzw. Maus-
bremse global aktivieren im Abschnitt Aktivierung.

4. Klicken Sie auf OK, um die Einstellungen anzuwenden oder verwerfen Sie Ihre 
Eingaben durch Klick auf Abbrechen.

Beschleunigungswert der Mausbremse konfigurieren

So legen Sie den Beschleunigungswert der Mausbremse fest:

1. Schalten Sie sich auf den Zielrechner auf, dessen Beschleunigungswert der Maus-
bremse Sie ändern möchten.

2. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

3. Klicken Sie im Menü auf System > Mausbremse konfigurieren.

4. Stellen Sie den gewünschten Beschleunigungswert über den Regler ein:

5. Klicken Sie auf Speichern, um die Einstellungen zu speichern oder verwerfen Sie 
Ihre Eingaben durch Klick auf Abbrechen.

HINWEIS: Bewegt sich die Maus auf dem Zielrechner zu schnell, verändern Sie 
den Regler nach links (Langsam). Im umgekehrten Fall bewegen Sie den Regler 
nach rechts (Schnell). 
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Erweiterte Funktionen

Bandbreitenmessung
Die zur Verfügung stehende Bandbreite innerhalb eines IP-Netzwerkes kann sich – je 
nach Auslastung des Netzwerkes – ändern. Dies kann zu einem Performanceverlust 
führen.

Falls Sie einen Performanceverlust feststellen, ist die Durchführung einer erneuten 
Bandbreitenmessung empfehlenswert.

So führen Sie eine erneute Bandbreitenmessung durch:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie in der Menüzeile auf System > Bandbreitenmessung.

Client-/Serverinformationen anzeigen
Informationen über die Software IP-Console Client (Client) und das Matrixsystem 
(Server) können Sie über das Hilfe-Menü auslesen.

So zeigen Sie die Client-/Serverinformationen an:

1. Öffnen Sie ggf. das Steuerboard mit der Tastenkombination Strg+Shift (Standard).

2. Klicken Sie im Menü auf Hilfe > Info.

3. Klicken Sie auf Client oder Server, um die entsprechenden Informationen anzuzei-
gen.

4. Klicken auf Schließen.

Systemweite Hotkeys im Client-Fenster
Innerhalb eines aktivierten Client-Fensters stehen Ihnen die folgenden Hotkeys 
während einer Sitzung zur Verfügung.

Strg+Shift+Maustaste Auslösen der Maus aus dem aktiven Client-Fenster

Strg+Shift+Num-Taste In Kombination mit einer Taste des Ziffernblocks der 
Tastatur können Sie innerhalb des Client-Fensters 
scrollen.

Weiterführende Informationen finden Sie im 
Abschnitt Verschieben des Fensterausschnittes (Scrollen) auf 
Seite 22.
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About this manual

This manual has been carefully compiled and examined to the state-of-the-art.

G&D neither explicitly nor implicitly takes guarantee or responsibility for the qual-
ity, efficiency and marketability of the product when used for a certain purpose that 
differs from the scope of service covered by this manual.

For damages which directly or indirectly result from the use of this manual as well 
as for incidental damages or consequential damages, G&D is liable only in cases of 
intent or gross negligence.

Caveat Emptor

G&D will not provide warranty for devices that:
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 Are repaired or modified by unauthorized personnel.
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 Have been damaged by non G&D accessories.

G&D will not be liable for any consequential damages that could occur from using 
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Proof of trademark
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»IP-Console Client« software
The IP-Console Client software provides a virtual console within the IP network. This 
virtual console enables the user to operate and configure the KVM matrix system.

Separate versions of this software are available for the following operating systems:

 Windows 
 GNU/Linux

System requirements
To install and operate the IP-Console Client software, the computer on which the soft-
ware is to be installed has to meet the following requirements.

Windows version

 approximately 20 MB available disk space
 Windows XP, 2003, Vista or 7
 tested Windows version:
 Microsoft Windows 7

GNU/Linux version

 approximately 20 MB available disk space
 at least 128 MB of system memory
 tested GNU/Linux distributions
 GNU/Linux Ubuntu 12.10
 GNU/Linux Ubuntu 13.04

NOTE: This manual describes how to operate the Windows version of the software.

The variants only differ in their optic design.
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Installation
The software is available in separate versions for Windows and GNU/Linux.

To install your version, proceed as described in the following paragraphs.

Windows version

How to install the software on a Windows operating system:

1. Put the installation CD into your CD drive.

2. Use the Windows explorer to open the CD directory \IPClient\English\Windows.

3. Run the Setup.exe file with a double-click.

4. Read the advices regarding the setup wizard and click Next.

5. Read the license agreements and confirm them by activating the option I agree.

6. Click Next.

7. Enter the desired folder at a local drive.

8. Select whether you want to install the software for the current user or for all users.

9. Confirm your entries by clicking Next.

10.Start the installation by clicking Next.

11.After the software has been installed, click Close.

GNU/Linux version

How to install the software on a supported GNU/Linux distribution:

1. Put the installation CD into your CD drive.

2. Open the CD directory \IPClient\English\Linux.

3. Run the command su -c ip-client-2.4.000-00634.run.

4. Enter the root password when requested.

NOTE: If you do not agree to the license agreement, the software cannot be 
installed!

ADVICE: Click Browse to view the tree view of the computer’s drives. This way, 
you can easily create and select the target directory.
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Getting started
This chapter describes the basic operation of the IP-Console Client software.

Starting the software
The following possibilities are provided to start the IP-Console Client software:

Windows

How to start the software on a supported Windows operating system:

 Click the following entries in the Windows start menu:
Start > Programs > Guntermann & Drunck GmbH > IP-Console > IP-Console Client

 Double-click the desktop shortcut of the IP-Console Client software.

GNU/Linux

How to start the software on a supported GNU/Linux distribution:

1. Enter the command ip-client in the command line.

2. Press Enter.

NOTE: The following chapters describe all functions and settings in detail.

NOTE: Please select your default language when starting the software for the first time.

NOTE: Please select your default language when starting the software for the first time.
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Establishing a connection to the KVM matrix system
After the software has been started, you can start a session with the KVM matrix sys-
tem. The virtual console is now displayed in the IP-Console Client software.

Starting a session with the KVM matrix system

How to start a session with the KVM matrix system:

1. Use the Session pull-down menu to select a session which has already been created.

2. Use the Authentication paragraph to enter the Username and the Password of your 
user account.

3. Use the Select your language paragraph to select your language (Deutsch or English).

4. Optional: Click Advanced if you want to configure advanced session settings 
(see next paragraph).

5. Start the connection (see page 17) by clicking Login.

Advanced session settings

Click Advanced in the login window to view or change the advanced session settings:

NOTE: The creation of a session profile is described on page 11.

IMPORTANT: Ask the administrator of the KVM matrix system if you are not 
familiar with the access data to the system.

NOTE: When starting the IP-Console Client software for the first time, the Initial 
start-up procedure (see page 16) is started.

Global mouse delay 
enabled:

If the mouse is accelerated on your local computer as 
well as on the target, the cursor on the target moves 
extremely fast and complicates the operation of the 
computers.

Activate this option (see page 42) to “slow down” the 
cursor speed.

Mouse gestures activated: Mouse gestures enable you to release the mouse from the 
client window and to open the control panel by executing the 
pre-configured mouse gestures (see page 40).

Autofit disabled: During each access, the automatic size adjustment 
adjusts the client window’s size to the target’s current 
resolution.

Disable this function if you want to define the client 
window’s width and height (see page 37).

Synchronize NumLock 
states:

This function synchronizes the switching status (on/off) of 
the »NumLock« key of the local computer and the target.
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The client window
After the IP-Console Client software has established a connection to the KVM matrix 
system, the client window is displayed on your monitor:

This window displays the on-screen display of the KVM matrix system or the moni-
tor image of the accessing target.

Information in the header

Synchronize CapsLock 
states:

This function synchronizes the switching status (on/off) of 
the »CapsLock« key of the local computer and the target.

Synchronize ScrollLock 
states:

This function synchronizes the switching status (on/off) of 
the »Scroll Lock« key of the local computer and the target.

Status bar: Use this option to select where the status bar is to be 
displayed (see page 25):

 Top
 Bottom

NOTE: Since the image of the on-screen display is not created by the KVM matrix 
system but by the IP-Console Client software, its position or the synchronisation set-
tings cannot be changed!
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The header of the client window displays the software name and the following infor-
mation:

Information in the status bar

The status bar displays the following information (from left to right):

Operating status: If the target can be operated in the client window, the square 
brackets display active operation.

Otherwise the square brackets display inactive operation.

Session name: The Session part displays the name of the connection settings 
that are required for establishing a connection.

Target name: The Target part displays the name of the accessing target.

Status symbol: The symbol indicates if one or several users are accessing the 
target.

Target name: Name of the accessing KVM matrix system target.

Video profile name: Name of the video profile which is assigned to the accessing 
target.

Image frequency: Number of image updates per second that are displayed in 
the client window.

Data transfer rate: Data transfer rate (in kilobyte per second) between KVM 
matrix system and IP-Console Client software.

»Num Lock« LED The LED is displayed in light green if the Num-Lock function 
is activated on the target.

If this function is disabled, the LED is displayed in dark 
green.

»Caps Lock« LED The LED is displayed in light green if the CapsLock key is 
activated on the target.

If the CapsLock key is not activated, the LED is displayed in 
dark green.

»Scroll Lock« LED The LED is displayed in light green if the Scroll-Lock function 
is activated on the target.

If this function is disabled, the LED is displayed in dark 
green.

NOTE: The status bar can either be displayed above or below the client window 
(see page 25).
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Releasing the mouse from the client window

If the on-screen display of either the KVM matrix system or the target can be oper-
ated in the client window, the square brackets display active operation.

The local computer can only be operated via input devices after the mouse has been 
released from the client window.

How to release the mouse from the client window:

 Press and hold the keys Ctrl+Shift while additionally pressing the left mouse key.

Scrolling an image section

If the screen resolution of the target is higher than the resolution on your computer, 
only a section of the target’s screen content can be displayed on your monitor.

Use the scrollbars of the client window or the buttons in the Scroll area of the control 
panel to select the section to be displayed.

How to select the section to be displayed by mouse:

 Click the scrollbars of the client window to select the section to be displayed.
 Click the buttons (see below) in the Scroll area of the control panel.

How to select the section to be displayed by keyboard:

1. Make sure the client window is activated and the »Num  Lock« function is disa-
bled.

2. Press Ctrl+Shift in combination with one of the navigation 
keys (Num key) of the numerical keyblock:

 The keys 8 (up), 6 (right), 2 (down) and 4 (left) move the 
image section in small steps.

 The keys 9 (top right), 3 (bottom right), 1 (bottom down) 
and 7 (top left) put the image section to the respective 
positions.

 The 5 key centres the image section in the middle.

NOTE: In this status, all keyboard entries and mouse activities at the local com-
puter are directly transmitted to the target.

ADVICE: You can also release the mouse with a mouse gesture (see page 40).
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Switching between targets
You can switch between the targets that are connected to the KVM matrix system 
by using the on-screen display or the control panel.

The following paragraphs provide a detailed description of each mode.

Accessing a target with the control panel

How to access a target with the control panel:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Target tab.

3. If necessary, use the filter function (see page 20) to limit the list of the targets.

4. Use mouse or keyboard (arrow keys, Pos 1 or End) to select a target.

5. Double-click the target or press Enter.

Switching via on-screen display (OSD)

How to access a target using the on-screen display:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the AdonIS button.

3. Use the arrow keys to select the target to be accessed.

4. Press Enter.

Switching between target and local computer
If keyboard and/or mouse activities are to be executed on your local computer dur-
ing a session on a target, you do not have to close your session or call the control 
panel.

The paragraph Releasing the mouse from the client window on page 7 provides detailed 
information regarding this topic.

ADVICE: Click the Last Target button (see page 21) to access the last active target.
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Viewing and editing basic data and comment
The basic data of a target are displayed if the Detail option in the list of the targets is 
applied.

As an alternative, the basic data as well as the comment of a target can be viewed in 
the properties window.

How to call the basic data and the comment of a target:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Target tab.

3. If necessary, use the filter function (see page 20) to limit the list of the targets.

4. Right-click the desired target and click Properties in the context menu.

The name, the physical address and the comment of the target are now displayed.

5. Optional: Enter any comment to the Comment field.

6. Click OK to save your settings or discard your changes by clicking Cancel.

Timeout during inactivity
If no keyboard or mouse activities are carried out during a time span of 60 minutes 
(default), the active session is about to be cancelled.

An window informs you that the active session is about to be cancelled and offers 
the following possibilities:

 Exit session: Click this button to close the current session immediately.
 Continue: Click this button to continue with the current session.

NOTE: The comment regarding the target can be edited.

IMPORTANT: If you do not react to the information window within 60 seconds, 
the active session is cancelled.
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Using hotkeys during a session
During your session, the following hotkeys are provided to be used in the active client 
window.

Closing the current session
There are two possibilities to close the current session: You can use the control 
panel to close the session or simply close the client window.

How to close the current session:

 If the control panel is open, click the menu Action > Exit session.
 You can also close the client window by clicking the window’s Close symbol.

Closing the software

How to close the software at your computer:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Action > Exit application.

Ctrl+Shift+Mouse key releases the mouse from the active client window

Ctrl+Shift+Num key Use this key combination in combination with the key-
board’s numeric pad to navigate in the client window.
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Administering session profiles
You can create a separate session profile for each G&D device in the IP network 
which provides an IP console.

Creating a new session profile

How to create a new session profile:

1. Click on New in the Session paragraph of the login mask.

2. Collect the basic data of the session profile:

3. Optional: Click Advanced if you want to make specifications regarding input mode, 
operation, encryption and/or bandwidth (see page 13).

4. Click OK to save the new session profile or discard your changes by clicking Can-
cel.

Session name: Name of the session profile

IP address/name: IP address of the G&D device

If the name has been resolved via a DNS server, enter the name here.

Port: Port number (default: 27998) through which the commu-
nication to the G&D device is established

Hotkey selection: Key combination to call the control panel (see page 19) during 
a session:

 Ctrl+Shift: key combination Ctrl + Shift
 Alt+Shift: key combination Alt + Shift
 Ctrl+Alt: key combination Ctrl + Alt

Open Access 
console:

Activate this option if the virtual console is operated in 
the Open Access operating mode.

In this case you are not required to enter your username and pass-
word when establishing a connection.



Administering session profiles
G&D IP-Console Client · 12

Editing a session profile

How to edit the settings of a session profile:

1. Select the profile to be edited in the Session paragraph of the login mask and click Edit.

2. Check and change the entered data of the session profile:

3. Optional: Click Advanced if you want to make specifications regarding input mode, 
operation, encryption and/or bandwidth (see page 13).

4. Click OK to save the new session profile or discard your changes by clicking Cancel.

Deleting a session profile
1. Select the profile to be deleted in the Session paragraph of the login mask and click 

Delete.

2. Check the information in the security request and click Yes to delete the session 
profile or Cancel to cancel the process.

Session name: Name of the session profile

IP address/name: IP address of the G&D device

If the name has been resolved via a DNS server, enter the 
name here.

Port: Port number (default: 27998) through which the commu-
nication to the G&D device is established

Hotkey selection: Key combination to call the control panel (see page 19) during 
a session:

 Ctrl+Shift: key combination Ctrl + Shift
 Alt+Shift: key combination Alt + Shift
 Ctrl+Alt: key combination Ctrl + Alt

Open Access 
console:

Activate this option if the virtual console is operated in 
the Open Access operating mode.

In this case you are not required to enter your username and pass-
word to establish a connection.
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Advanced settings of the session profile
Click Advanced in the settings of a session profile (see page 12) to display additional 
input windows and selection windows.

These windows enable you to make specifications regarding the input mode, opera-
tion, encryption and/or bandwidth (see page 13).

Input mode

After a new profile has been created, the Direct Keyboard Input function is automati-
cally activated.

As a result, the keyboard inputs at the local computer are transmitted to the target 
even if the client window is inactive (see page 6).

Operation

At IP-based KVM products, analog keyboard, video and mouse signals are digital-
ised before they are transmitted over the IP network.

Depending on the resolution and color depth of the target’s video signal, the pro-
vided bandwidth can be highly strained due to high data traffic.

To reduce this effect you can use the Operation section to define how the provided 
bandwidth is to be used preferably.

The following three possibilities are provided for adjustment:

NOTE: The focus has to lie on the client window to forward the keyboard inputs to 
the target, .

NOTE: When applying a GNU/Linux distribution, the control panel has to be 
closed before you can make inputs to the inactive client window.

NOTE: The performance might be influenced for narrow-band connections. As a 
result, only a minimal bandwidth is provided for the mouse signal which compli-
cates the fluid operation of the mouse.

view and 
operate:

The screen layout and the cursor are treated equally.

This setting is recommended if a LAN connection is applied (default).

view: The screen layout is treated preferentially.

This setting is recommended if the task mainly consists of “viewing” when a 
narrow-band connection is applied.

operate: The cursor is treated preferentially.

This setting is recommended if the task mainly consists of administering and 
configuring the target and a fast screen layout is secondary when using a nar-
row-band connection.
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Encryption

The transmitted data between the KVM matrix system and the software can be 
secured by applying encryption options.

The transmission of authentication data is always secured. Additionally, you can 
encrypt the data of keyboard and mouse activities and of the transmitted video signal.

The following options for encryption are provided:

IMPORTANT: In case sensitive data is being displayed and edited on the target, 
activate the encryption of the Input and the Video channel for transmitting data via 
the internet.

If the data traffic is transmitted via a secure VPN connection, the encryption is not 
required.

NOTE: Please mind that every additional encryption requires time and influences 
the performance.

CTRL channel: This channel transmits the exchanged data for the login proce-
dure at the KVM matrix system.

The data  transmitted on this channel is always encrypted.

Input channel: This channel transmits the keyboard/mouse signals to the KVM 
matrix system.

If this channel is not encrypted, IP packets can be sniffed.

Encryption is optional and can lead to small performance losses due to higher 
data traffic.

Video channel: This channel transmits the target’s video signal to the 
IP-Console Client software.

If this channel is not encrypted, the transmitted image can be 
restored by sniffed IP packets.

Encryption is optional and can lead to small performance losses due to higher 
data traffic.
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Bandwidth

If a new profile is created, the Bandwidth recognition function (see page 17) is automat-
ically activated.

During the course of establishing the connection, this function determines the band-
width of the connection between the KVM matrix system and the local computer on 
which the IP-Console Client software is applied.

Now, the determined value is applied to edit and transmit video information.

 As an alternative to the Bandwidth recognition, define one of the listed bandwidths to 
be applied when establishing a connection.

NOTE: The provided bandwidth within an IP network can vary depending on the 
network load. This might lead to performance losses.

Re-execute the bandwidth recognition during the session (see page 44) if you notice 
performance losses.

ADVICE: The defined value can be adjusted during a session by performing the 
bandwidth recognition (see page 44).
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Initial start-up procedure
The initial start-up procedure is started when the IP-Console Client software is used for 
the first time.

In this mode, all switched-on targets of the KVM matrix system are accessed one after 
the other. During this process, a video profile is created for each target. This profile 
stores the image position, phases and color values.

The wizard displays the progress of the video profile creation. The duration depends 
on the amount of targets.

Manually starting the initial start-up procedure
If the initial start-up procedure was cancelled during the initial start of the software, 
you can re-execute the procedure at any time.

How to manually start the initial start-up procedure:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click on the menus System > Initial start-up procedure.

3. Follow the instructions of the wizard for the initial start-up procedure.

NOTE: Please follow the instructions of the wizard for the initial start-up procedure.

ADVICE: The initial start-up procedure can be canceled at any time.

The video profiles that could not be created due to an untimely abort are created and 
saved when the target is accessed for the first time.
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Establishing a connection
When establishing a connection, a window opens on your screen. This window informs 
you about the current status of the connection establishment:

This window displays the following information (from top to bottom):

 Progress bar: Here, you can see the current progress of the login procedure. The cur-
rently executed activity is displayed above the bar.

 Channel encryption: The different channels and the applied encryptions (see page 14) 
are displayed.

 Operating mode: The current operating mode is displayed for your information.

Detecting the average bandwidth
If no bandwidth has been defined for the active session profile (see page 15) and the 
Bandwidth recognition is activated, the bandwidth is detected while the connection is 
being established.

Now, the detected value is being applied to edit and transmit the video information.

NOTE: Depending on the operating mode, some functions that are described in 
this manual are possibly not available.

ADVICE: Click on Advanced while the bandwidth is being detected to display the cur-
rently detected bandwidth in the form of a curve.

NOTE: The provided bandwidth within an IP network can vary depending on the 
network load. This might lead to performance losses.

If necessary, re-execute the bandwidth recognition during the session (see 
page 44) if you notice performance losses.
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Chat function
The IP-Console Client software can be installed on several computers in the IP network.

The software’s chat function enables the user who logs in to the system to contact an 
already logged-in user.

Both users can use the chat to agree on the further procedure.

How to use the chat to agree on the further procedure if the console is already 
occupied:

1. Establish a connection (see page 4).

2. Click Yes to open the chat window.

3. The chat window is displayed on your screen and on the screen of the other user.

4. Enter your message in the input field and click Send or press Enter to send your 
message to the other user.

5. The other user’s message is displayed in the text field in the upper section of the 
window. You can answer this message as described in step 4.

The chat is closed if the other user denies or accepts your request or if you cancel the 
login procedure by clicking Exit session.

NOTE: Only one user can access the IP console at the same time.

NOTE: Your screen now displays a window which informs you that the IP con-
sole is currently occupied and offers to contact the other user.

IMPORTANT: If no button is clicked within 10 seconds, the connection estab-
lishment is cancelled.

NOTE: If the connection cannot be established because the progcess was can-
celled by clicking No, the login mask is displayed again.

NOTE: If the other user does not answer within 45 seconds or clicks on Deny or Exit 
session, his session is automatically being cancelled and your session is being 
established.
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Control panel

The control panel is the operating centre of the IP-Console Client software. All impor-
tant functions can be accessed via the control panel:

 switching between the available targets
 calling the on-screen display of the KVM matrix system
 executing keyboard macros
 scrolling the visible screen contents in the software’s client window
 selecting the image sections to be displayed

The user interface
The user interface provides you with the status displays and tools listed in the fol-
lowing paragraph.

Status display of the connection

The Link Status field displays the current status of the serial connection 
between the IP-Console Client software and the KVM matrix system.

NOTE: The connection transmits the information and switching states to be dis-
played on the on-screen display to the software.
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Displaying the software’s operating mode

The current operating mode is displayed for your information.

Menu bar

The menu bar displays the  commands that are currently available (Action, Edit, Tar-
get or Macros, Video, System, View, Help).

Filter function

The filter function above the list of the target enables you to limit the displayed targets.

How to limit the list of displayed targets by using the filter function:

1. Enter any string to the text field.

2. The Target tab only displays the computers that contain the entered string in the 
Target, Physical address or Comment column.

3. Click Delete to discard the filtering.

The connection has been properly established.

The connection is interrupted.

NOTE: Depending on the operating mode, some of the described 
functions may not be available.

NOTE: Depending on the activated tab of the control panel, either the Target or 
Macro menu item is displayed.
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Accessing the last target (Last Target)

The Last Target function enables you to access the last active target from the cur-
rently active target.

How to access the last active target:

1. Click the Last Target symbol next to the filter field.

Scrolling the image section

If the screen resolution of the target is higher than the resolution on your computer, 
only a section of the target’s screen content can be displayed on your monitor.

You can use the buttons in the Scroll area of the control panel to select the section to 
be displayed. Further information regarding this topic are provided in the paragraph 
Scrolling an image section on page 7.

Information in the status bar

The status bar provides the following information (from left to right):

Control panel tabs

The tabs in the middle of the window take the biggest part of the control panel. Here, 
you can display the Targets or Macros tabs:

 The Target tab contains a list of the connected targets.
For each target, the following information is displayed:

NOTE: If you accessed no target since the start of the IP-Console Client software or 
you only worked on the currently accessing target, this function is not provided.

Video profile name: Name of the video profile which is assigned to the accessing 
target

Image frequency: Number of image updates per second that are displayed in 
the client window

Data transfer rate: Data transfer rate (in kilobyte per second) between KVM 
matrix system and the IP-Console Client software.

Target: target name in the KVM matrix system

Phys. Addr.: the target’s physical address

Status: the target’s switching status (on or off)

Access: access right for the target
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The symbols that are put in front of the target names have the following meaning:

 The Macros tab enables you to execute keyboard macros (see page 33).

Options to display the tab entries

The lists of Targets and Macros can be displayed in the following display modes:

 Symbols: displays big symbols and the name (on top of each other)
 List: displays small symbols and the name (next to each other)
 Details: displays small symbols, the name as well as other information in the form 

of a table

How to change the display modes to display the Targets or Macros:

1. Open the control panel of the software.

2. Open the View menu.

3. Select the Symbols, List or Details menu item.

Displaying the on-screen display via the control panel

The on-screen display (OSD) of the KVM matrix system can be dis-
played in the client window. The OSD enables you to operate and 
configure the system.

You are accessing this target.

Another user is accessing this target.

Several users are accessing the target.

The target is switched on (green spot).

The target is switched off (red spot).

ADVICE: The keyboard macros to be displayed can be filtered by selecting a 
group (see page 35).

NOTE: Since the display of the on-screen display is not created by the KVM matrix 
system but by the IP-Console Client software, the position and the synchronisation 
settings cannot be changed!
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How to display the on-screen display of the KVM matrix system in the 
client window:

1. Click the AdonIS button.

Feasible action in the control panel

Closing the control panel

Close the control panel to continue your work in the software’s client window.

How to close the control panel:

1. Use the menu bar to click on Action > Close control panel.

Exiting the session

Exit the session at the KVM matrix system after you have finished your work or to 
enable another user to use the IP console.

How to exit the session:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Action > Exit session.

Exiting the software

How to exit the application at your computer:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Action > Exit application.

Switching to full screen mode of the client window

If the target provides the same display resolution as your local computer, we recom-
mend to display the client window in full screen mode.

In this mode, the client window is enlarged to full screen size so that the full screen 
is available for the image of the target.

ADVICE: While working in the client window of a target, the OSD of the KVM 
matrix system can be called by pressing Ctrl+Num (default).

NOTE: Task bars and other operating elements on your desktop are covered by the 
full screen of the client window.

It is not necessary to scroll in the client window when the full screen mode is acti-
vated.
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How to switch the client window to full screen mode:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Full screen or press F11.

Scaling the video image of accessing computers

If the computer on which you run the software IP-Console Client supports the pro-
gramming interface OpenGL, scaling is auto-enabled.

Scaling adjusts the image of the accessing computer to the client window if the 
image resolution of this computer is higher than the resolution of the client window.

You can manually enable or disable the scaling function.

How to enable/disable scaling:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Scaling to change the current mode.

Enabling/Disabling anti-aliasing of the scaled video image

Aliasing can have a negative impact on the quality of scaled images. In this case, 
enable the anti-aliasing function. With this function, the transition to the adjacent 
colour within the image is adjusted to prevent aliasing.

You can enable or disable anti-aliasing only if the scaling function is enabled.

How to enable/disable anti-aliasing:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Anti-aliasing to change the current mode.

NOTE: The functions Scaling and Anti-aliasing cannot be used on computers that do 
not support the programming interface OpenGL (Open Graphics Library).

NOTE: If the function is enabled, the menu item is marked.

NOTE: If the function is enabled, the menu item is marked.
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Pasting the clipboard content

You can copy any text to the clipboard of your local computer and paste it within 
the client window.

How to paste the clipboard content within the client window:

1. Open the control panel of the software.

2. Use the menu bar to click on Edit > Paste (EN).

Screenshot

For reasons of documentation, for example, you can use the software to make a 
screenshot of the target in the client window.

How to create a screenshot of the target:

1. Open the control panel of the software.

2. Use the menu bar to click on Video > Screenshot of target.

3. Select location and file type (*.png or *.bmp).

4. Enter your file name and click on Save.

Defining the position of the status bar

The client window’s status bar can either be displayed at the window’s top (default) 
or bottom.

How to define the position of the client window’s status bar:

1. Open the control panel of the software.

2. Use the menu bar to click on View > Status bar > Upper edge or View > Status bar > 
Lower edge.

ADVICE: If the target’s keyboard layout does not comply with the selected lan-
guage of the IP-Console Client software, change the layout by clicking on the 
menu items Edit > Paste extended > Paste as DE.
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Video profiles
As described in the chapter Initial start-up procedure on page 16, this mode or the ini-
tial access to a target enables you to create and save a video profile.

Each video profile has an individual name. The basic structure of the names created by 
the software and edited by the user has the following syntax:

 [pixels_horizontal]×[pixels_vertical]@[repetition rate_vertical]

Detailed information about the video profiles

Displaying detailed information

How to call the settings of the current video profile:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Edit active profile.

How to call the settings of any video profile:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Target tab.

3. Right-click a target and click on Properties.

4. Click the Video profile tab.

NOTE: The Auto- string is put in front of video profiles that were created after the tar-
get was accessed for the first time and whose color values were not detected.

The EIM- string is put in front of video profiles that were created during the initial 
start-up procedure or with the Create video profile function.

ADVICE: The current measuring values of the video signal (type of synchronisa-
tion, repetition rate and image height) can be viewed in the menu Video > Video set-
tings > View of the control panel.
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The »Video profile« tab

The Video profile tab is divided into two parts:

 Active Profile: displays the profile which is currently applied
 Further Profiles: displays further video profiles which have been created for this target

The following information are displayed for each video profile:

NOTE: The booting phase, the login procedure at the operating system, and the tar-
get’s user interface are often displayed with different monitor resolutions.

In such cases, separate video profiles are displayed due to the different video charac-
teristics.

IMPORTANT: Video profiles of targets that are currently not accessing the system 
can also be viewed, edited or deleted.

The upper part of the window always displays the profile of the currently accessing
target. The lower part of the window lists all available video profiles of the selected 
targets.

Name: video profile name

Resolution: horizontal and vertical resolution as well as vertical repetition rate of 
the video profile

Source: displays by which “source” the profile has been created:

 Auto: video profile has been created during the first access on a target
 C-Auto: video profile has been created during the initial start-up proce-

dure or with the create video profile function
 User: settings and/or the video profile name have been edited by the 

user
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Creating and editing video profiles

Creating a new video profile

As described in the chapter Initial start-up procedure on page 16, this mode creates and 
saves a full video profile (incl. detection of color values).

How to create a video profile for a particular target:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Target tab.

3. Double-click the target you want to access.

4. Use the menu bar to click on Video > Create video profile.

Changing a video profile

All data of a video profile can be edited and adjusted  (image position, phase shift and 
color values).

How to change the settings of the current video profile:

1. Open the control panel using the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Edit active profile.

3. Change the setting(s) of the video profile (see page 29 f.).

4. Click Save to save your settings or discard your changes by clicking Cancel.

How to change the settings of the any video profile:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Target tab.

3. Right-click a target and click on Properties.

4. Click the Video profile tab.

5. Use the Active Profile or Further Profiles  paragraph to select the video profile to be 
edited.

NOTE: If the initial start-up procedure was cancelled during the initial start of the 
software and has not been executed again, a full video profile of a target might not 
be available.

NOTE: This menu item can only be selected if the video profile has not yet been cre-
ated!
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6. Click Edit.

7. Change the setting(s) of the video profile (see page 29 f.).

8. Click Save to save your settings or discard your changes by clicking Cancel.

Deleting a video profile

How to delete a video profile:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Target tab.

3. Right-click a target and click on Properties.

4. Click the Video profile tab.

5. Use the Active Profile or Further Profiles paragraph to select the video profile to be 
deleted.

6. Click Delete.

Setting options
The user is enabled to edit the profile’s video settings. The following pages describe 
the  settings that are provided on the different tabs of the window.

The lower window section is identical on all tabs:

The left corner displays the number of image updates per second in the client win-
dow (image frequency) as well as the data transfer rate (in kilobyte per second) 
between KVM matrix system and IP-Console Client software.

The following operating elements can also be found in this section:

NOTE: If the active video profile is deleted, the software automatically creates a 
new video profile.

display directly: changes in the settings are immediately applied to the image 
screen in the client window

Test: applies changes in the settings for the display screen in the client 
window

Refresh: synchronizes the transmitted image of the target

Cancel: cancels changes in the settings and close window

Close: temporarily saves settings until the target is accessed again
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Defining the image width, position and size

The Image tab enables you to define the image width, the position and the size.

The following settings can be individually optimised:

Save: save settings

Undo: undo all changes since last saving

ADVICE: If you want this tab’s settings to be automatically determined, click on 
Image position recognition.

The following requirements are necessary to execute this function reliably:

 The screen resolution of the target is lower than the resolution of the client window.
 The setting of the frames of the currently accessing target computer lie within a  

gegnerated size (depending on the image resolution).

Image width: image width (incl. back porch) in pixel

The image width is always bigger than the width of the actually visible 
image section!

Vertical 
image position:

pixel (vertical) from which the image starts from

Vertical 
image size:

height of the visible image section

When adjusting the image height you can orient yourself to the usual 
image resolutions (e. g. 1024 × 768).

Adjust the image height in way that no black frame remains and the image 
is fully visible.

Horizontal 
image position:

pixel (horizontal) from which the image starts from

Horizontal 
image size:

width of the visible image section

When adjusting the image width you can orient yourself to the usual 
image resolutions (e. g. 1024 × 768).

Adjust the image position in way that no black frame remains at the left 
side and the image is fully visible.
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How to change the preset values:

1. Change your values in the different input fields.

It is recommended not to enter the numeric values directly at the keyboard but to 
use the arrow keys.

Defining color values

The Colors tab enables you to individually adjust the color values and the brightness 
of the image.

The following settings can be optimised:

How to change the preset values:

1. Use the slider to adjust the color values and the brightness.

It is also possible to enter the values directly to the particular input fields.

ADVICE: If the display directly function (see page 29) is activated, you can change 
the settings and, at the same time, view the result in the client window.

NOTE: Click Undo to activate the default values of this tab.

ADVICE: If you want this tab’s settings to be automatically determined, click on 
Image position recognition.

Red: sets the color values for the color red

Green: sets the color values for the color green

Blue: sets the color values for the color blue

Synchronize 
color settings:

Activate this option if you want to adjust the contrast. When the 
color value is changed, the other two colors are adjusted as well.

If this function is deactivated (default), you can change the 
weight of the single colors, for example to correct a color fault 
in the image.

Brightness: adjusts the basic brightness of the image

ADVICE: If the display directly function (see page 29) is activated, you can change 
the settings and, at the same time, view the result in the client window.

NOTE: Click Undo to activate the default values of this tab. 
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Adjusting the phase position

The setting of the phase position is an important setting to properly process the 
video signal.

How to change the preset phase setting:

1. Select the manually option in the Settings paragraph.

2. Adjust the value according to your needs.

It is recommended not to enter the numeric values directly at the keyboard but to 
use the arrow keys.

3. Optional: If desired, activate the Noise suppression option.

ADVICE: The Auto phase function automatically executes the phase setting.

To properly perform this function, a static image (for example of the desktop) has 
to be output by the target.

This function cannot be performed if the screensaver is activated on the target!

ADVICE: If possible, display a vertically hatched image or an image with many 
vertical lines at the target. Now, optimise the phase value to that effect that the 
lines are evenly and sharply displayed.

ADVICE: If the display directly function (see page 29) is activated, the settings can be 
changed and, at the same time, the result can be viewed in the client window.

NOTE: Click Undo to activate the default values of this tab. 
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Keyboard macros
Many users use shortcuts for a fast and efficient operation of the operating system or 
the application software.

When operating the target via the IP console of the KVM matrix system, three 
devices are arranged in the communication line: the target, the matrix switch and 
the local computer on which the IP-Console Client software is executed.

Use the keyboard macros of the control panel as described in this chapter to ensure 
that the key combinations are forwarded to the target.

Executing a keyboard macro
The keyboard macros can either be executed via the control panel or via the selected 
key combinations that have been selected in the settings of the keyboard macro.

How to execute a keyboard macro using the control panel:

1. Open the control panel withthe key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Double-click the macro to be executed.

How to execute a keyboard macro using a key combination:

1. Click the client window to activate it.

2. Press the key combination Ctrl+Shift and the F key which is assigned to the key-
board macro to be executed.

IMPORTANT: If you press a key combination, for example Ctrl+Alt+Delete, the local 
computer interprets this key combination which is therefore not transmitted to the 
target.
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Administering keyboard macros

Creating keyboard macros

How to create a new keyboard macro:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Use the menu bar to click on Macros > New.

4. Use the Name field to enter the name of the macro you want to create.

5. Use the tabs above the virtual keyboard to select your keyboard layout  
(PC keyboard or SUN keyboard) and the language.

6. Use the virtual keyboard to enter a key sequence.

7. Optional: Click on Edit group assignment to assign the new macro to any number of 
groups (see page 35).

Use the mouse to mark one or several groups to which you want to assign the 
new macro to.

8. Optional: If you want to execute the keyboard macro with a key combination, 
select any F key in the row Hotkey.

9. Click OK to create the new keyboard macro or discard your inputs by clicking Cancel.

ADVICE: You can also change the layouts during your inputs.

NOTE: Clicking a virtual key is interpreted as pressing and holding of the key. 
The virtually pressed keys are displayed in light grey.

The Hotkey field displays the this key’s shortcut whereas the Scancode field shows 
the respective key code.

ADVICE: Click Delete or Delete all to undo the last or all keypresses.

EXAMPLE: If you want to create a keyboard macro for the key combination 
Ctrl+C, first click the left Ctrl key followed by he C key.

When leaving this dialogue, the key codes to realease the pressed keys are cre-
ated and added in reversed order.

NOTE: All new macros are always assigned to the All group.

ADVICE: Hold the Ctrl key to select several groups.

NOTE: F keys that have already been used for other keyboard macros are no 
longer displayed.
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Editing keyboard macros

How to edit an already defined keyboard macro:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Right-click the macro to be edited and click on Edit in the context menu.

4. Change the settings of the keyboard macro.

Deleting keyboard macros

How to delete an already defined keyboard macro:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Right-click the macro to be deleted and click on Delete in the context menu.

Macro groups
In order to quickly find a specific macro among the multitude of macros, the macros 
can be grouped.

Filtering the macros with the help of groups

How to limit the keyboard macros to be displayed on the Macros tab:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Use the Macro group field to select the group whose macros are to be listed.

NOTE: The different settings are described in the paragraph Creating keyboard macros
on page 34.

NOTE: The standard configuration provides the groups Linux, Novell, G&D Hotkeys, 
SUN, VMWare, Windows and special keys.

ADVICE: If you created the macro group Favorites, the macros of this group are dis-
played when the Macros tab is called for the first time during a session.
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Creating a new macro group

How to create a new macro group:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Right-click on a free space in the macros list and click on Edit groups in the context 
menu.

4. Click on New group.

5. Enter the new group name.

6. Click OK to create the new group or discard your changes by clicking Cancel.

Renaming a macro group

How to rename a macro group:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Right-click on a free space in the macros list and click on Edit groups in the context 
menu.

4. Click the group to be renamed and click on Edit.

5. Enter the new group name.

6. Click OK to rename the group or discard your changes by clicking Cancel.

Deleting a macro group

How to delete a macro group:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click the Macros tab.

3. Right-click on a free space in the macros list and click on Edit groups in the context 
menu.

4. Click the group to be deleted and click on Delete.

5. Click OK to save your settings or discard your changes by clicking Cancel.
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Video functions
Automatically adjusting the size of the client window (AutoFit)

During each access, the automatic size adjustment adjusts the size of the client win-
dow to the target’s current resolution.

If the screen resolution of the target is higher than the resolution of your computer, 
you can scroll the image section to be displayed within the client window (see 
page 7).

How to change the settings of the AutoFit function in the advanced session settings:

1. Click Advanced in the left corner of the login mask.

2. In the default setting, the AutoFit function is activated and the AutoFit disabled 
option is deactivated.

If you want to deactivate this function, activate the Autofit disabled function and 
define the client window’s width and height (in pixels).

3. Click OK to apply your settings or discard your changes by clicking Cancel.

How to (de)activate the AutoFit function via the Video menu:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > AutoFit.

ADVICE: We recommend to set the resolution of your local computer higher than 
the target’s resolution.

NOTE: The Autofit functions can be adjusted in the advanced session settings as 
well as in the Video menu.

NOTE: If you change the size of the client window during a session, this change 
only applies for this session.

After you have started a new session, the defined size applies again.

NOTE: A marker next to the menu item indicates if this function is activated.
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Manually adjusting the size of the client window (Fit Profile)

In the default the AutoFit function (see last paragraph) ensures that the size of the cli-
ent window is geared to the resolution of the accessing target.

If you have changed the size of the client window manually, the AutoFit function is 
deactivated. When accessing another target, the size of the client window is not 
taken over.

The Fit Profile function enables you to adjust the client window to the resolution of 
the currently accessed target.

How to adjust the size of the client window to the currently accessing target:

1. Open the control panel using the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Fit Profile.

Refreshing the full screen content

The Refresh image function enables you to transmit the full screen content. Any image 
artefacts that might appear are removed by the retransmission.

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Refresh image.

Resynchronizing the image

The Resynchronize image function enables you to fully transmit the full screen content 
as well as to automatically recognize the phase.

How to fully synchronize the image:

1. Open the control panel withthe key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Resynchronize image.

IMPORTANT: Unlike with the AutoFit function, this adjustment only applies for the 
currently accessing target.

ADVICE: This function can also activated by pressing F5 if the control panel is active.
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Automatically recognizing the phasing

The Auto phase function automatically recognizes the phasing. 

How to execute the automatic phase recognition:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Auto phase.

Automatically defining the color values

The Auto color adjustment function enables the automatic definition of the target’s 
color values.

How to automatically define the color values:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Auto color adjustment.

Automatically recognizing the image position

The Recognize image position enables the automatic recognition of the target’s image 
position.

How to recognize the image position:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on Video > Video settings > Recognize image position.
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Mouse gestures
Executing pre-configured mouse gestures enables you to release the mouse from the client 
window (see page 7) and to open the control panel (see page 19):

Using mouse gestures
If the operation of the on-screen display of the KVM matrix system or of the target is 
active within the client window, the square brackets display Active operation.

How to use a mouse gesture:

 Move the mouse according to the mouse gestures.

Activating mouse gestures
The support of mouse gestures can be adjusted before the connection is established (via 
the login mask) or during the session (via the control panel).

How to (de)activate mouse gestures before establishing a connection:

1. Click Advanced in the left corner of the login mask.

2. Activate or deactivate the Mouse gestures activated option.

3. Click OK to apply your settings or discard your changes by clicking Cancel.

How to (de)activate the application of mouse gestures within a session:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click on System > Activate mouse gestures to reverse the current setting.

Mouse gesture Function

left-right-left releases the mouse from the client window

up-down-up opens the control panel

IMPORTANT: Mouse gestures can only be executed in this status.

ADVICE: If necessary, configure the preset time span to trigger the mouse gestures 
(see page 41).

NOTE: A marker next to the menu item indicates if this function is activated.
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Configuring the time span to recognize 
mouse gestures
If the pre-configured mouse movement has been recognized, the assigned function is 
triggered.

Adjust the speed to carry out the functions of the mouse gestures in a way which allows 
you to reliably trigger the desired action with the mouse gesture.

How to define a time span to recognize mouse gestures:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on System > Configure mouse gestures.

3. Adjust the time span to recognize the single mouse gestures with the different 
sliders in a way which allows you to reliably trigger the desired action with the 
mouse gesture.

4. Click Save to apply your settings or discard your changes by clicking Cancel.
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Mouse delay
Many operating systems provide the users with a so-called mouse acceleration.

If the mouse is accelerated on your local computer as well as on the target, the cursor 
moves very fast and complicates the operation.

Difference between global and individual mouse delay
By activating the mouse delay, you can select between the global and the individual 
mouse delay.

 global mouse delay: activates the mouse delay for all targets of the system
 individual mouse delay: activates the mouse delay for all currently accessing targets

Activating the mouse delay
The activation of the mouse delay can be adjusted before the connection is established 
(via the login mask) or during the session (via the control panel).

How to (de)activate the global mouse delay before establishing a connection:

1. Click Advanced in the left corner of the login mask.

2. (De)activate the option Global mouse delay enabled.

3. Click OK to apply your settings or discard your changes by clicking Cancel.

NOTE: The mouse acceleration of the operating systems does not only evaluate the 
distance the mouse is being moved but also the duration of this movement.

During “long” movements the cursor movement on the screen is accelerated.

NOTE: If one of the two mouse delay versions is activated, this version applies for 
targets whose acceleration value has already been adjusted.

The default value applies for targets whose acceleration value has not yet been 
configured.

NOTE: The global setting can also be executed according to the description in the 
following paragraph.
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How to (de)activate the global or individual mouse delay within a session:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click on System > Configure mouse delay.

3. (De)activate the Enable mouse delay or Enable global mouse delay options.

4. Click OK to apply your settings or discard your changes by clicking Cancel.

Configuring the acceleration value for the mouse delay

How to define the acceleration value for the mouse delay:

1. Access the target for which the acceleration value of the mouse delay is to be 
changed.

2. Open the control panel with the key combination Ctrl+Shift (default).

3. Use the menu bar to click on System > Configure mouse delay.

4. Use the slider to adjust the acceleration value:

5. Click Save to save your settings or discard your changes by clicking Cancel.

NOTE: If the mouse moves too fast on the target, move the slider to the left 
(Slow). For the opposite, move the slider to the right (Fast). 
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Advanced functions

Bandwidth recognition
The provided bandwidth within an IP network can vary depending on the network 
load. This might lead to a performance loss.

If you detect losses in the performance, it is recommended to re-execute the band-
width recognition.

How to execute the bandwidth recognition:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Use the menu bar to click on System > Bandwidth recognition.

Displaying client/server information
The help menu can be used to read out information on the IP-Console Client (Client) 
software and the KVM matrix system.

How to display client/server information:

1. Open the control panel with the key combination Ctrl+Shift (default).

2. Click Help > Info.

3. Click Client or Server to display the respective information.

4. Click Close.

Systemwide hotkeys in the client window
The following hotkeys are provided within an active client window:

Ctrl+Shift+Mouse key releases the mouse from the active client window

Ctrl+Shift+Num key In combination with a key of the keyboard’s keypad 
you are enabled to scroll within the client window.

The paragraph Scrolling the image section on page 21 
provides further information regarding this topic.
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